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Déclaration 
Copyright ©2020. Tous droits réservés. 
Sans l’autorisation écrite de l’entreprise, aucune entreprise ni aucune personne n’est habilitée à extraire, à dupliquer une partie ou la 
totalité du contenu de ce manuel ni à diffuser celui-ci sous quelque forme que ce soit. 
Au fur et à mesure de la mise à niveau des produits ou pour toute autre raison, le contenu du manuel sera mis à jour périodiquement. 
Sauf indication contraire, le manuel est utilisé comme une REMARQUE. Toutes les déclarations, informations et suggestions du 
manuel ne constituent aucune garantie explicite ou implicite. 
Les photographies, graphiques, tableaux et illustrations fournis dans le manuel sont fournis à des fins d’explication et d’illustration 
uniquement et peuvent différer de produits spécifiques.  

 

Consignes de sécurité 

 ATTENTION 

  
 Ne pas placer ni installer l’équipement directement sous la lumière du soleil ou à proximité d’un appareil de chauffage. 
 Ne pas installer l’équipement dans un endroit humide ou un endroit exposé à la poussière ou à la suie.  
 Garder l’équipement installé horizontalement ou installer l’équipement dans un endroit stable. Éviter que l’équipement ne 

tombe.  
 Éviter que du liquide ne tombe sur l’équipement. Veiller à ce qu’aucun objet (des tasses, par ex.) de liquide ne se trouve sur 

l’équipement et éviter toute fuite de liquide. 
 Installer le dispositif dans un endroit bien ventilé ; ne pas obstruer les évents de l’équipement. 
 N’utiliser l’équipement qu’en respectant les limites d’entrée/sortie nominales. 
 Ne pas démonter le dispositif. 
 Transporter, utiliser et stocker l’équipement en respectant les taux d’humidité (10 à 90 %) et la température (-10 ℃ à +55 °C).  
 Avant de nettoyer l’appareil, débrancher le cordon d’alimentation et couper complètement l’alimentation. 
 La poussière sur la carte de circuits imprimés à l’intérieur du NVR peut provoquer un court-circuit après avoir été exposée à 

l’humidité. Nettoyer régulièrement la carte de circuits imprimés, les connecteurs, le châssis et le ventilateur du châssis avec 
une brosse douce. Si la saleté est difficile à éliminer, la retirer avec un détergent neutre dilué dans de l’eau et essuyer. 

 N’utiliser pas de solvants volatils tels que de l’alcool, du benzène ou un diluant pour nettoyer le dispositif. Ne pas utiliser 
d’agents de nettoyage puissants ou abrasifs. Cela pourrait endommager le revêtement de surface. 

 Acheter le disque dur dédié à l’enregistreur NVR recommandé par le fabricant de l’équipement auprès des canaux officiels 
pour garantir la qualité et le respect des spécifications d’utilisation du disque dur. 

 S’assurer qu’il n’y a pas de menace due à une charge mécanique inégale. 
 Veiller à ce que les câbles vidéo et audio disposent de suffisamment de commandes pour installer le câble. Le rayon de 

courbure du câble ne doit pas être inférieur à 5 fois le diamètre du câble. 
 Vérifier que le câble d’alarme est fermement installé et que le contact est bon. 
 Veiller à ce que le NVR soit correctement mis à la terre. 
 

 AVERTISSEMENT 

 
 Utiliser la batterie comme demandé, sinon cela pourrait entraîner une ignition ou une explosion de la batterie ou un risque de 

brûlure ! 
 Lors du changement de batterie, utiliser une batterie de même type. 
 Utiliser les ensembles de cordons recommandés (cordons d’alimentation), en respectant les spécifications nominales.  
 Lorsque le produit est connecté à Internet, l’utilisateur le fait à vos propres risques, notamment en ce qui concerne les produits 

susceptibles de faire l’objet de cyber-attaques, d’attaques de piratage, d’infections virales, etc. La société décline toute 
responsabilité en cas d’anomalies du produit, de fuites d’informations, etc. En revanche, elle fournira en temps opportun une 
assistance technique liée aux produits. 

 REMARQUE 
 Après avoir reçu le produit, ouvrir la boîte d’emballage, sortir l’équipement et vérifier que le produit et les accessoires dans 

l’emballage correspondent à la liste de colisage contenue dans la boîte. 
 Si le contenu de la boîte est endommagé ou s’il manque des pièces, contacter le revendeur sans délai 
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Chapitre 1 Présentation et caractéristiques 
 
1.1 Valeurs par défaut 
 
 L’administrateur par défaut défini en usine est admin et le mot de passe est admin 
 La valeur par défaut du réseau défini en usine est DHCP. 
 

1.2 Fonctions et caractéristiques  
 
 Format de compression vidéo H.264, prend en charge la résolution 

4K/6M/5M/4M/3M/2M/1080P 
/720P/D1 (en fonction du modèle)  
 
 Format de compression audio G.711U, G711a, ADPCM_DVI4, AAC. 
 Prend en charge la fonction appel vocal. 
 Chaque canal prend en charge le codage à trois flux, y compris le flux MJPEG. 
 Interface utilisateur de style Windows intégrée au système d’exploitation Linux3.0 en 

temps réel. 
 Prend en charge de l’ajustement indépendant des paramètres de codage pour chaque 

canal, y compris le type de codage, la résolution, la fréquence d’images et le débit 
binaire. 

 Prend en charge de la capture manuelle et de la lecture d’image. 
 Prend en charge la prévisualisation, l’enregistrement, la lecture, la sauvegarde. 
 NVR prend en charge la prévisualisation sur deux écrans et PoE, détection de 

franchissement, intrusion régionale, détection de séjour de personnes ou de 
rassemblement de personnes, selon le cas. 

 USB2.0 ou 3.0 prend en charge la sauvegarde, la mise à niveau du logiciel et le 
fonctionnement de la souris. L’appareil ne prend en charge que les disques USB au 
format FAT32 et NTFS. 

 XVR prend en charge l’entrée AHD, TVI, CIV, CVBS, IPC (hybride, 5 en 1). 
 
 Surveillance locale 
Les fonctionnalités de surveillance locales sont répertoriées ci-dessous : 
 Prend en charge la sortie homologue locale VGA et HD, et la HD prend en charge une 

sortie de résolution jusqu’à 4K. 
 NVR 4 canaux prend en charge la prévisualisation sur 1 à 4 écrans, NVR 8 canaux 

prend en charge la prévisualisation sur 1 / 4 / 8 écrans, NVR 16 canaux prend en charge 
la prévisualisation sur 1 / 4 / 8 / 9 / 16, NVR 32 canaux prend en charge la 
prévisualisation sur 1 / 4 / 8 / 9 / 16 / 25 / 32 écrans. 

 Prend en charge le réglage de l’ordre des canaux de prévisualisation en faisant glisser la 
souris. 

 Prend en charge la prévisualisation manuelle ou la prévisualisation auto-tour ; le cycle 
d’interrogation automatique peut être défini.  

 Prend en charge la détection de mouvement vidéo, la détection de perte vidéo et la 
détection intelligente. 

 Assure le contrôle de la caméra IP PTZ via le protocole ONVIF. 
 
 Gestion du disque dur 
Les fonctions de gestion du disque dur sont les suivantes : 
 Chaque interface SATA prend en charge jusqu’à 8 To de disque dur. 
 Prend en charge le formatage du disque dur. 
 Prend en charge la perte de disque dur et l’alarme en cas d’anomalie du disque dur. 
 
 Enregistrement et lecture vidéo 
Les fonctions d’enregistrement et de lecture vidéo sont les suivantes : 
 La compression vidéo standard est H.264 / H.264+ / H.265 / H.265+, avec fonction 

enregistrement chronométré. 
 Prend en charge la configuration des calendriers d’enregistrement en utilisant des 

procédés de dessin et d’édition. 
 Prend en charge l’enregistrement du flux principal et du flux secondaire en même temps. 
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 Prend en charge l’écriture cyclique. 
 Un maximum de 6 heures différentes d’enregistrement peut être défini par jour, et le 

mode de déclenchement des enregistrements peut être défini indépendamment pour 
différentes périodes de temps. 

 Les modes de déclenchement d’enregistrement incluent Normal, Motion (Mouvement), 
Alarm (Alarme), M&A, Intelligent. 

 Prend en charge la récupération et la lecture des données vidéo par canal, type de vidéo 
et date. 

 Plusieurs modes de lecture : Play/Pause (Lecture/Pause), Reverse (Inversé), Stop, 
Single Back (Retour simple), Single Forward (Avant simple), Speed Down (Ralenti), 
Speed Up (Accéléré), prend en charge le positionnement par glisser de souris. 

 L’utilisateur peut sélectionner n’importe quelle zone de l’écran pour faire un zoom avant 
localement. 

 Prend en charge la lecture vidéo simultanée de plusieurs canaux. 
 
 Gestion des utilisateurs 
 Gestion des utilisateurs à trois niveaux d’autorité, les administrateurs peuvent créer 

plusieurs utilisateurs d’opération et définir leurs droits, les droits pouvant être affinés en 
fonction du canal. 

 
 Sauvegarde des données 
Les fonctionnalités de sauvegarde des données sont les suivantes : 
 Prend en charge la sauvegarde via l’interface USB2.0 ou USB3.0. 
 Prend en charge les disques externes (disques U) ou les disques durs mobiles en 

FAT32, NTFS, ex-FAT et d’autres formats. 
 Prend en charge la sauvegarde par lots par fichier et par heure. 
 Prend en charge les sauvegardes Smart CMS clip par clip. 
 Prend en charge la page Web pour extraire et télécharger des fichiers vidéo par heure. 
 

 Gestion des alarmes et des exceptions 
Les fonctions de gestion des alarmes et des exceptions sont les suivantes : 
 Certains modèles prennent en charge l’entrée et la sortie d’alarme externe multicanaux. 
 Prend en charge l’alarme de perte vidéo, l’alarme de mouvement, l’alarme de 

déconnexion du réseau, l’alarme de conflit IP, l’erreur de disque dur et l’alarme 
d’absence de disque. 

 Prend en charge la détection des visages de notre caméra IP intelligente (IPC), le 
franchissement, l’intrusion sectorielle, le séjour de personnes, le rassemblement de 
personnes et d’autres détections intelligentes d’accès et de liaison. 

 Diverses alarmes peuvent déclencher une alarme sonore, l’envoi de courrier 
électronique et l’affichage à l’écran. 

 Diverses alarmes peuvent déclencher l’affichage d’invites d’alarme, des avertissements 
vocaux et envoyer des e-mails pour avertir les utilisateurs. 

 
 

 Autres fonctions locales 
D’autres fonctions locales sont les suivantes : 
 Les utilisateurs peuvent régler rapidement et facilement les paramètres du système à 

l’aide des boutons NVR frontaux et de la souris. 
 L’administrateur peut créer des utilisateurs multiples et définir des autorisations, qui 

peuvent être affinées en fonction du canal. 
 Opérations achevées, alarmes, exceptions, consignation et récupération d’informations. 
 Certains modèles prennent en charge les alarmes locales et mettent à niveau les 

fonctionnalités frontales.  
 Prend en charge la fonction « geste de passe ». 
 
 Fonction réseau 
Les fonctions réseau sont les suivantes : 
 Prend en charge l’interface réseau adaptative 10M / 100M / 1000M. (selon le modèle). 
 Prend en charge l’accès privilégié de clients distants, améliore la sécurité du système. 
 Prend en charge le cluster de protocoles TCP/IP, prend en charge DHCP, DNS, HTP, 

SMTP, RTSP, UPnP, HTTPS et d’autres protocoles. 
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 SERVEUR WEB intégré. 
 Prend en charge la recherche, la lecture et la sauvegarde à distance. 
 Prend en charge les paramètres d’accès et de configuration à distance. 
 Prend en charge l’accès à distance à l’état de fonctionnement de l’équipement, au 

journal système et à l’état des alarmes. 
 Prend en charge le formatage de disque dur, le programme de mise à niveau, le 

redémarrage et d’autres opérations à distance pour la maintenance du système. 
 Prend en charge le déclenchement et l’arrêt manuels de l’enregistrement à distance. 
 Prend en charge le déclenchement et l’arrêt manuels d’alarmes à distance. 
 Prend en charge la fonction poussées d’alarmes. 
 Prend en charge la configuration à distance du serveur FTP. 
 Prend en charge le contrôle PTZ à distance. 
 Prend en charge l’application Comelit View Smart. 
 Prend en charge l’accès par protocole ONVIF à la plate-forme. 
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Chapitre 2 Aspect 

2.1 Panneau avant 
2.1.1 Le panneau avant 
(À titre d’information uniquement, sujet à modification)  
 

 
Figure 2-1 

 
 

N° Nom Description 

1 Interrupteur Marche / Arrêt du dispositif 

2 Voyant du disque dur 
Indique si le disque dur et correctement 
connecté. 

3 Voyant d’alimentation Le dispositif est sous tension. 

4 Voyant réseau 
Indique si le dispositif est correctement 
connecté au réseau. 

5 USB2.0 
Permet de connecter la souris ou une clé 
USB de sauvegarde. 
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 Le diagramme du panneau ne reflète pas la taille ni les proportions du produit. Pour les 
détails, se référer au produit réel. 

 
 
2.2 Panneau arrière 
2.2.1 Présentation du panneau arrière de l’équipement général  
Le schéma du panneau arrière de l’équipement courant est comme suit : 

 
Figure 2-2 

 
La description correspondante de chaque interface sur la Figure 2-2 est présentée dans le 
tableau suivant : 
 

N° Nom Description 

1 
Port Ethernet 
1/2  

Permet de se connecter au réseau 

2 Sortie audio Interface de sortie audio de l’équipement 

3 Entrée audio Interface d’entrée audio de l’équipement 

4 
Sortie vidéo 
HD 2 

Pour connecter des périphériques d’affichage HD 
comme des écrans d’ordinateur. 

5 VGA 
Pour connecter des périphériques d’affichage VGA 
comme des écrans d’ordinateur. 

6 
Sortie vidéo 
HD 1 

Pour connecter des périphériques d’affichage HD 
comme des écrans d’ordinateur. 

7 USB3.0 Pour connecter la souris ou une clé USB 

8 eSATA Interface pour disque dur externe 

9 Masse 485 Avertit quand l’équipement est mis à la terre 

10 Sortie alarme Interface de sortie d’alarme de l’équipement 

11 
Entrée 
alarme 

Interface d’entrée d’alarme de l’équipement 

12 

Commutateu
r à bascule 
d’alimentatio
n 

Commutateur 115 V/230 V 

13 
Connecteur 
d’alimentatio
n 

Connecteur d’alimentation du dispositif 

14 Interrupteur Commutateur de l’équipement 

Tableau 2-1 
 

2.2.2 Présentation du panneau arrière du dispositif PoE incorporé 
Le schéma du panneau arrière de l’équipement courant est comme suit : 
 

 
Figure 2-3 
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La description correspondante de chaque interface sur la Figure 2-3 est présentée dans le 
tableau suivant : 
 

N° Interface Connexion REMARQUE 

1 
Sortie vidéo 
HD  

Pour connecter des périphériques d’affichage HD 
comme des écrans d’ordinateur. 

2 VGA 
Pour connecter des périphériques d’affichage VGA 
comme des écrans d’ordinateur. 

3 Entrée audio Interface d’entrée audio de l’équipement 

4 Sortie audio Interface de sortie audio de l’équipement 

5 
Port réseau 
PoE 

Permet de connecter des appareils IP et d’alimenter 
des appareils et des réseaux IP. 

6 Port Ethernet  Permet de se connecter au réseau 

7 Port USB 
Pour connecter la souris, une clé USB ou un disque 
dur amovible 

8 
Connecteur 
d’alimentatio
n 

Connecteur d’alimentation du dispositif 

 

 REMARQUE 
 Le diagramme du panneau ne reflète pas la taille ni les proportions du produit. Pour les 

détails, se référer au produit réel. 
 

2.3 Description de la souris 
Piloter le NVR avec le bouton gauche, le bouton droit et la molette de la souris. 
 

Actions de la 
souris 

Fonction 

Bouton de 
gauche de la 
souris 

1. Pour sélectionner l’une des options 
2. Pour insérer le curseur, entrer ou modifier la 
valeur d’un paramètre 
3. En cours de lecture, cliquer sur la ligne de temps 
pour modifier la position de lecture. 

Bouton de 
droite de la 
souris 

1. Quand l’interface n’est pas verrouillée, cliquer 
avec le bouton droit de la souris, le menu système 
apparaît. 
2. Quand l’interface est verrouillée, cliquer avec le 
bouton droit sur l’interface de prévisualisation en 
temps réel, l’interface de connexion apparaît.  
3. Cliquer avec le bouton droit de la souris sur le 
sous-menu pour retourner au menu précédent 

Double-cliquer 
avec le bouton 
gauche de la 
souris 

A l’état prévisualisation et lecture, permet de 
basculer entre écran unique et écrans multiples. 

Déplacement à 
l’aide de la 
souris 

1. À l’état de commande pan/tilt 
(panoramique/inclinaison), la direction peut être 
modifiée.  
2. Dans les réglages du secteur de l’alarme 
d’occlusion vidéo et de détection de mouvement, 
définir l’étendue du secteur.  
3. Faire glisser le secteur du zoom électronique.  
4. Dans l’interface de prévisualisation, sélectionner 
un canal et appuyer et faites glisser pour basculer 
vers d’autres emplacements de canal.  
5. Lors de la lecture de la vidéo, faire glisser la barre 
de progression pour atteindre le fichier vidéo à lire. 
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Tourner la 
molette de 
défilement de 
la souris. 

1. Réglage de l’heure 
2. Sélectionner les valeurs dans le menu déroulant. 
3. Lors de la prévisualisation, il est possible de 
changer de canal de prévisualisation.  
4. En mode zoom électronique, il est possible de 
faire un zoom avant et un zoom arrière sur l’image 
vidéo. 

 

2.4 Introduction à la méthode de saisie 
La méthode de saisie comprend des caractères latins minuscules et majuscules. Cliquer sur 

le bouton  sur la gauche permet de passer alternativement en minuscules et 

majuscules et le symbole  permet de supprimer une saisie incorrecte, comme illustré sur 
la Figure 2-4 et la Figure 2-5. 
 
 

 
 Figure 2-4 Caractères latins majuscules 

 
 Figure 2-5 Caractères latins minuscules 
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Chapitre 3 Connexion 
 
3.1 Installation du disque dur 

 ATTENTION 

  
 Avant de commencer l’installation, vérifier que l’alimentation a été déconnectée. 
 Utiliser le disque dur du moniteur dédié au NVR recommandé par le fabricant du 

dispositif. 
 
Outils d’installation 
Un tournevis Phillips 
 

Installation du disque dur 

Le disque dur doit être installé comme illustré sur la Figure 3-1. 
(1) Desserrer la vis de fixation sur le couvercle, ouvrir le couvercle. 
(2) Connecter une extrémité du câble de données du disque dur et du câble d’alimentation à 
la carte mère, et connecter l’autre extrémité au disque dur.  
(3) Tenir le disque dur d’une main, retourner le châssis et fixer le disque dur avec une vis à la 
position indiquée. 
(4) Retourner le châssis, fixer le couvercle avec la vis. 
 

  
(1)                         (2) 

  
(3)                           (4) 

Figure 3-1 
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3.2 Connexion du dispositif 
Utiliser un câble VGA ou un câble HD pour transmettre le signal du NVR à l’écran. S’il s’agit 
d’un PTZ contrôlable, utiliser un fil pour connecter le câble RS485 A et le câble RS485 B à 
l’interface RS485 correspondante sur le NVR, comme illustré sur la Figure 3-2. 
 

 
Figure 3.-2 

 ATTENTION 

 Les dispositifs dotés de ports réseau PoE intégrés prennent en charge la fonctionnalité 
plug-and-play de la caméra IPC. Lors de l’ajout de dispositifs IP à l’aide de la méthode 
plug-and-play du port réseau PoE, s’assurer que les dispositifs IP prennent également 
en charge la norme PoE. 
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Chapitre 4 Mise en route 
 
4.1 Initialisation du système 
Les étapes pour la mise en route du dispositif sont les suivantes : 

○1  Connecter le dispositif au moniteur et brancher la souris et le cordon d’alimentation. 

○2  Allumer l’interrupteur d’alimentation sur le panneau arrière pour démarrer l’appareil. 

L’écran d’initialisation du système apparaît, comme illustré sur la Figure 4-1.  
 
 

 
Figure 4-1 

 ATTENTION 

 Vérifier que la tension de l’alimentation utilisée correspond bien aux spécifications du 
NVR et s’assurer que la masse du NVR est bien mise à la terre. 

 Si l’alimentation n’est pas conforme, le NVR peut ne pas fonctionner correctement. Cela 
peut même endommager le NVR. Il est recommandé d’utiliser une alimentation régulée. 

 

REMARQUE 
 Une fois le dispositif démarré, il peut être simplement configuré via l’assistant de 

démarrage, qui correspond au fonctionnement normal du dispositif.  
 

4.2 Assistant de démarrage 
4.2.1 Assistant de démarrage rapide 
Configurer le NVR comme illustré sur la Figure 4-2 :  

○1  Sélectionner la langue du système et cliquer sur « Apply » (Appliquer). 
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Figure 4-2 ○1  

○2  Sélectionner un utilisateur, saisir le mot de passe, sélectionner la langue du système et 

cliquer sur « Login » (Connexion) pour se connecter au système (le nom d’utilisateur par 
défaut est admin, le mot de passe est admin). 
 

 

Figure 4-2 ○2  

○3  Lorsque le mot de passe de connexion est trop simple, une invite de mot de passe de 

sécurité apparaît. Cliquer sur « Modify » (Modifier). 
 

 

Figure 4-2 ○3  

 

○4  Cliquer sur la case « New password » (Nouveau mot de passe), saisir un nouveau mot de 

passe, confirmer le nouveau mot de passe, sélectionner la question de sécurité, saisir la 
réponse correspondante, cliquer sur « Save » (Sauvegarder), insérer une clé USB dans 
l’appareil et cliquer sur « Export Key » (Exporter clé). 
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Figure 4-2 ○4   

 
Unlock Pattern (Motif de déverrouillage) : Cocher « Unlock Pattern » (Motif de 
déverrouillage), tracer le motif de déverrouillage d’au moins 4 points deux fois avec la souris 
pour terminer le réglage du modèle de déverrouillage. 
 
 

○5  Accéder à l’interface « Date and Time » (Date et heure), configurer la date et l’heure du 

dispositif, puis cliquer sur "Suivant ».   
 

 

Figure 4-2 ○5  

 

○6  Aller dans l’interface « Network » (Réseau), configurer les paramètres réseau de 

l’appareil. Cliquer sur Next (Suivant).  
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Figure 4-2 ○6  

○7  Accéder à l’interface « Hard Disk » (Disque dur) pour connaître l’état d’utilisation du 

disque dur. Lorsque l’état indique « In Use » (En cours d’utilisation), cliquer sur Next 
(Suivant). 
Lorsque l’état indique « not mounted » (non monté), sélectionner le disque dur, cliquer sur 
« Format → Confirm » (Formater, Confirmer). Le dispositif redémarre et le disque dur est 
formaté. 
 

 

Figure 4-2 ○7  

○8  Aller dans l’interface « Camera ». L’utilisateur peut rechercher et ajouter des appareils et 

cliquer sur « Next » (Suivant).  
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Figure 4-2 ○8  

 

○9  Aller à l’interface « Change Password » (Changer mot de passe), définir le mot de passe du 

système et les questions de sécurité en fonction des besoins réels, cliquer sur « Complete » 
(Terminer). L’assistant de démarrage est configuré.  
 

 

Figure 4-2 ○9  

REMARQUE 
 Sur l’écran de l’assistant de démarrage, cliquer sur « Exit → Confirm » (Quitter, 

Conformer) pour quitter l’assistant de démarrage. 
 Dans l’interface de réglage de la date et de l’heure, décocher « Enable Wizard » (Activer 

l’assistant). Le système n’affichera plus l’interface « Boot Wizard » (Assistant de 
démarrage) après le prochain démarrage. 

 Lorsque le mot de passe est trop simple, après la connexion, une interface de sécurité 
de la force du mot de passe apparaîtra. L’utilisateur peut cliquer sur « Modify later » 
(Modifier plus tard) pour continuer à utiliser le mot de passe existant. 

 Pour n’importe quelle interface de l’assistant de démarrage, si aucune modification n’est 
requise, cliquer sur « Next » (Suivant) pour accéder directement à l’interface suivante. 

 Vérifier que le dispositif NVR a été correctement connecté au réseau avant de configurer 
les paramètres réseau. 

 Le disque dur doit être formaté lors de sa première installation sur le dispositif. 
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4.2.2 Forget Password (Mot de passe oublié) 
En cas d’oubli du mot de passe, cliquer sur « Forget password » (Mot de passe oublié) sur la 
page de connexion pour accéder à l’interface Forget password (comme illustrée sur la 
Figure 4-3) afin de réinitialiser le mot de passe. Il existe trois façons de réinitialiser le mot de 
passe : « Answer the question » (Répondre à la question), « Import Key » (Importer clé) et 
« Dynamic Password » (Mot de passe dynamique). 
 

 
Figure 4-3 

 
 Answer The Question (Répondre à la question) : Sélectionner les trois questions de 

sécurité lors de la définition du mot de passe et entrer la réponse à la question 
correspondante, cliquer sur « Next Step » (Étape suivante) pour accéder à la nouvelle 
interface de configuration du mot de passe, comme illustré sur la Figure 4-4. 
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Figure 4-4 

 
 Import Key (Importer clé) : Sélectionner la méthode d’authentification « Import Key » 

(Importer clé), comme illustré sur la Figure 4-5. 
 

 
Figure 4-5 

 

○1  Insérer la clé USB (sur laquelle le fichier de clé a été stocké lors de la définition du mot de 

passe du dispositif) sur le dispositif, et cliquer sur « Import » pour importer le fichier de clé. 

○2  Dans l’interface Change Password, sélectionner « Change Password » (Modifier le mot de 

passe), saisir un nouveau mot de passe, confirmer le mot de passe et cliquer sur « Save » 
(Sauvegarder), comme illustré sur la Figure 4-6. 
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Figure 4-6 

 
 Dynamic Password (Mot de passe dynamique) : Sélectionner la méthode 

d’authentification « Dynamic Password » (Mot de passe dynamique) comme illustré sur 
la Figure 4-7. 

 

 
 

Figure 4-7 

○1  Contacter le fournisseur pour obtenir le code de sécurité, saisir l’emplacement du code de 

sécurité et cliquer sur « Next Step » (Étape suivante). 

○2  Dans l’interface Change Password, sélectionner « Change Password » (Modifier mot de 
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passe), saisir un nouveau mot de passe, confirmer le mot de passe et cliquer sur « Save » 
(Sauvegarder). 
 

REMARQUE 
 Lorsque « Answer The Question » (Répondre à la question) est sélectionné, il faut 

répondre à au moins 2 questions, et la réponse doit être exactement la même que la 
réponse définie lors de la définition du mot de passe avant d’entrer dans l’interface 
« Modify User » (Modifier l’utilisateur). 

 Lorsque « Import Key » (Importer clé) est sélectionné, le fichier de clé sur la clé USB doit 
être le fichier de clé exporté par ce dispositif. 

 

4.3 Interface de prévisualisation 
Une fois le système complètement démarré, il accédera à l’interface de prévisualisation par 
défaut, comme illustré sur la Figure 4-8. 
 

 
 

Figure 4-8 
Après le démarrage normal du dispositif, le paramètre par défaut est la prévisualisation en 
mode d’affichage multi-écran. Les produits avec des canaux différents ont des quantités 
différentes d’écrans partagés à afficher. Sur l’interface de prévisualisation, il est possible de 
définir la date et l’heure appropriées. En bas à gauche de l’écran est indiqué le mode 
d’enregistrement de chaque canal vidéo ou une icône d’état d’alarme.  
La fonction de chaque icône est indiquée dans le tableau suivant : 

Icône Fonction 

 
Le canal de surveillance est en mode vidéo. 

 

Le canal de surveillance est en mode détection de 
mouvement. 

 

Le canal de surveillance est en mode alarme 
intelligente. 

Tableau 4-1 
 

4.4 Ajout rapide de dispositif 
La fonction Ajout rapide de dispositif est illustrée sur la Figure 4-9 : 

○1  Dans le menu de prévisualisation, pour le canal de la caméra IP non connectée, cliquer 

sur l’icône «  ». 
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Figure 4-9 ○1  

○2  Sélectionner le dispositif à ajouter et cliquer sur «  » pour l’ajouter. 

 

 

Figure 4-9 ○2  

 
 Search (Rechercher) : Cliquer pour rechercher tous les périphériques IP en ligne dans 

le LAN selon le protocole dans la case « Filter » (Filtre). 
 Add (Ajouter) : Sélectionner un dispositif. 
 Manual Add (Ajout Manuel) : Pour plus de détails sur la saisie manuelle des 

informations sur le dispositif, voir 5.3.5.1.  
 Filtre (Filtre) : Sélectionner les conditions de filtre d’affichage et cliquer sur « Search » 

(Rechercher), le dispositif recherche et affiche toutes les IPC du LAN qui remplissent les 
conditions. 

 

REMARQUE 
 Filtre de recherche Add Device (Ajouter un appareil) : Dans l’interface Add Device 

(Ajouter un dispositif), sélectionner le protocole correspondant dans la colonne « Filter » 
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→ « Search » (Rechercher) → Select Device (Sélectionner le dispositif) → Cliquer sur 

«  ». 
 Manual Add (Ajout Manuel) : Sur l’interface Device Search (Recherche de dispositif), 

cliquer sur « Manual add » (Ajout manuel) → Cliquer sur « Enable » (Activer) → Select 
Protocol (Sélectionner Protocole), Saisir le mot de passe, IP, Port → cliquer sur « Save » 
(Sauvegarder). 

 

4.5 Menu de raccourcis de canaux 
Après avoir ajouté un dispositif à un canal, cliquer sur le canal. Le menu de raccourcis 
apparaît comme illustré sur la Figure 4-10.  
 

 
 Figure 4-10 

 
La fonction de chaque icône est indiquée dans le tableau suivant : 
 

Icône Fonction 

 

Capture manuelle – cliquer sur ce bouton pour 
capturer les images vidéo en cours. Recherche, 
visualisation et sauvegarde d’images peuvent être 

effectuées dans « File Management » 
(Gestion des fichiers) → « All Files » (Tous les 
fichiers). 

 

Bouton de lecture instantanée – cliquer sur ce bouton 
pour lire le canal 5 minutes avant la vidéo. 

 
PTZ – cliquer pour passer à l’interface PTZ. 

 

Bouton de contrôle de sortie audio – cliquer sur ce 
bouton pour régler le volume de sortie du canal ou 
couper le son. 

 

Bouton de zoom électronique – cliquer sur ce bouton 
pour accéder au mode zoom plein écran, afficher 
l’image non agrandie du canal dans le coin inférieur 
droit de l’écran, et faire glisser le cadre rouge de 
l’image non agrandie à l’aide de la souris pour 
changer la position de l’image agrandie. Cliquer sur 

«  » et sur «  » ou utiliser la molette de la 
souris pour régler le zoom. Cliquer avec le bouton 
droit de la souris pour quitter le zoom électronique et 
restaurer l’interface de prévisualisation en direct. 

 

Bouton de couleur de l’image – cliquer dans 
l’interface Image pour définir la luminosité du canal, le 
contraste, la saturation, la netteté, la lumière 
d’appoint, le réglage de l’exposition, la balance des 
blancs, le réglage vidéo des valeurs des paramètres. 

 

Bouton d’informations sur le flux binaire – lorsque la 
souris se déplace vers la position de l’icône, le canal 
affiche le flux en cours ainsi que d’autres paramètres 
associés. 

 

Permet d’activer / désactiver le canal pour un 
enregistrement chronométré toute la journée. 

 

Permet de basculer entre flux principal et flux 
secondaire. 
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Fonction d’activation de l’affichage Fisheye 

Tableau 4-2 
 
4.5.1 PTZ 

Cliquer sur «  » sur le canal connecté à PTZ pour accéder à l’interface de réglage PTZ, 
où il est possible d’effectuer des opérations telles que la vitesse PTZ, sens et zoom, comme 

illustré sur la Figure 4-11. ○1  

 

 

Figure 4-11 ○1  

 
L’interface de configuration PTZ est divisée en PTZ Control (Contrôle PTZ) et Common 
Control (Contrôle commun). 
  
 
 PTZ Control (Contrôle PTZ) 
L’interface PTZ Control (Contrôle PTZ) permet de définir la rotation de direction PTZ (y 
compris haut, bas, gauche, droite, supérieure gauche, inférieure gauche, supérieure droite et 
inférieure droite) du mécanisme à rotule, la mise au point, le zoom, l’ouverture, le 
positionnement rapide et le tour, etc. À utiliser avec les touches de direction lors du réglage, 

comme illustré sur la Figure 4-11 ○2 .  

 

  

Figure 4-11 ○2  
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 Channel (Canal) : Permet de sélectionner le canal où se trouve le dispositif PTZ. 

 Zoom : Cliquer sur  /  pour régler le zoom avant/arrière de la caméra. 

 (Focus) Mise au point : Cliquer sur  /  pour régler la mise au point de la 
caméra. 

 Iris (Diaphragme) : Cliquer sur  /  pour régler la luminosité de la caméra. 
 Speed (Vitesse) : Permet de contrôler la vitesse du mode panoramique/inclinaison. Par 

exemple, la vitesse de rotation par pas de 7 est nettement supérieure à la vitesse de 
rotation par pas de 1. 

 Direction (Sens) : Utiliser / / / / / / /  pour ajuster le sens 
de la caméra PTZ. 

 
 Common Control (Contrôle commun) 
Sur l’interface de configuration PTZ, cliquer sur « Common Control » (Contrôle commun) pour 
accéder à l’interface de contrôle commun. Common Control permet d’appeler des points de 
présélection, de sélectionner la ligne de tour pour activer/désactiver le mode tour, comme 

illustré sur la Figure 4-11 ○3  : 

 

 

 Figure 4-11 ○3  

 
 Preset (Présélection) : Permet de sélectionner un point de présélection. 
 Call (Appeler) : Cliquer sur le PTZ pour passer directement à la position du point de 

présélection sélectionné. 
 Cruise (Tour) : Permet de sélectionner l’itinéraire de tour qui a été défini et cliquer pour 

activer/désactiver le tour. 
 Cruise on (tour activé) : Permet de suivre la ligne de tour pour commencer le tour. 
 Cruise off (tour désactivé) : Permet de fermer la ligne de tour en cours. 
 
4.5.2 Image 
Dans l’interface de réglage de la couleur de l’image, l’utilisateur peut définir les paramètres 
d’image du canal de l’IPC, tels que la luminosité, le contraste, la coupure IR (IRcut) et la 
balance des blancs.  
Les étapes de configuration de l’image sont les suivantes : 

Étape 1 : Cliquer sur «  » à partir du canal de l’IPC pour accéder à l’interface de réglage 
de la couleur de l’image du canal, comme illustré sur la Figure 4-12. 
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Figure 4-12 

 
Étape 2 : Sélectionner le canal de configuration. 
Étape 3 : Définir le réglage image, la lumière d’appoint, l’exposition, le rétroéclairage, la 
balance des blancs et le réglage vidéo en fonction des besoins réels. 
Étape 4 : Cliquer sur « Apply » (Appliquer) pour enregistrer les réglages. 

 
 Image adjustment (Réglage de l’image) : Selon l’environnement réel, l’utilisateur peut 

régler la luminosité, le contraste, la saturation et la netteté de l’écran de prévisualisation 
en faisant glisser la barre de progression. L’utilisateur peut également définir la valeur 
derrière la barre de progression, « Brightness » (Luminosité), « Contrast », 
« Saturation », « Sharpness » (Netteté). Les valeurs valides sont comprises entre 0 et 
255 et la valeur par défaut est 128. 

 Fill light (Lumière d’appoint) : Par défaut, le mode est « Auto » (automatique), la 
sensibilité est de 3, le temps de filtrage est de 3, la luminosité est de 100. Lorsque Fill 
light (Lumière d’appoint) est en mode est « Auto », le dispositif allume la lumière 
d’appoint en fonction de l’environnement actuel. L’utilisateur peut basculer le mode 
d’appoint sur « Day » (Jour), « Night » (Nuit) et « Scheduled switch » (Commutation 
programmée) en fonction de la scène vidéo réelle de la scène, et changer la sensibilité 
et le temps de filtrage du dispositif en fonction du mode de remplissage. Lorsque le 
mode d’éclairage d’appoint est « Scheduled switch » (Commutation programmée), 
l’utilisateur peut régler l’heure de lumière du jour et d’obscurité (c’est-à-dire l’heure de 
début et de fin de remplissage), ainsi que la luminosité de la lumière d’appoint. 
 Lorsque le mode d’appoint est « Day » (Jour), la vidéo du moniteur du dispositif est 

ajoutée à l’effet jour. 
 Lorsque le mode d’appoint est « Night » (Nuit), la vidéo du moniteur du dispositif est 

patché en un effet de nuit. 
 Filtering time (Temps de filtrage) : Il est utilisé pour empêcher la lumière ambiante 

de s’améliorer et la lumière est fréquemment allumée et éteinte, et le temps de 
filtrage est réglé. Pendant cette période, la caméra n’est pas perturbée par la 
lumière ambiante. 

 Light brightness (Luminosité de l’éclairage) : Cette option permet de régler la 
luminosité de la lumière d’appoint. La plage de réglage est de 0 à 100. 

 Exposure Settings (Réglages d’exposition) : La valeur par défaut est Auto, qui change 
le mode manuel en fonction des besoins du moment. Lorsque « Manual » (Manuel) est 
sélectionné, la durée d’exposition et la commande de gain sont activées. 

 Backlight (Contre-jour) : Cette option permet de régler la compensation du contre-jour 
et la suppression de forte intensité lumineuse. La valeur par défaut est Off (désactivée). 
Elle peut être activée manuellement et le contre-jour est réglable. 

 White balance (Balance des blancs) : La valeur par défaut est Auto et peut être 
commutée sur « Manual » (Manuelle).  
 Manual white balance (Balance des blancs manuelle) : Prend en charge le gain 

R, V, B réglable. La plage de réglage est (0-255). Cliquer sur « Save » 
(Sauvegarder) après le réglage. 
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 Video Adjustment (Réglage vidéo) : Ici, l’utilisateur peut activer et définir la réduction 
de bruit numérique 2D ou 3D. 

 Image Enhancement (Amélioration Image) : Permet à l’utilisateur de sélectionner le 
mode de contrôle du scintillement, d’activer et régler l’intensité dynamique large. 
 Flicker control (Contrôle du papillotement) : Le mode Flicker control est 

sélectionné en fonction de l’environnement d’installation de la caméra IPC et de la 
norme de papillotement. La norme PAL est 50 Hz et la norme NTSC est 60 Hz. 
Lorsque le dispositif est installé à l’extérieur, il peut être sélectionné à l’extérieur. Le 
paramètre par défaut est PAL. 

 Sensor linear WDR (Capteur linéaire WDR) : La valeur par défaut est 
« Shutdown » (Fermeture). L’utilisateur peut changer la force dynamique large dans 
le menu déroulant. Les options sont Automatic, Weak, Moderate, Strong, Super 
(Automatique, Faible, Modérée, Forte, Super). 

 Defog Mode (Mode désembuage) : Utilisé pour régler le mode de désembuage et la 
force. 
 Defog Mode (Mode désembuage) : La valeur par défaut est Off (désactivé) et 

l’utilisateur peut sélectionner On (Activé) ou Auto (Automatique) dans le menu 
déroulant. 

 Defog strength (Intensité du désembuage) : La valeur par défaut est 0. Lorsque le 
mode de désembuage est activé, l’intensité de désembuage peut être réglée. La 
plage des valeurs possibles est de 0 à 255. 

REMARQUE  
 L’interface d’image de la caméra affiche uniquement les fonctions de prise en charge du 

dispositif. L’interface spécifique dépend du produit réel. 
 

 
 

Chapitre 5 Menu NVR 
 
5.1 Menu des raccourcis 
Une fois connecté au système, déplacer la souris vers le bas de l’interface de 
prévisualisation. Un menu contextuel de raccourcis apparaît, comme illustré sur la Figure 5-1. 
L’utilisateur peut accéder à l’interface pour effectuer certains réglages pertinents. Tels que 
démarrage (gestion des fichiers, paramètres système, déconnexion, arrêt), lecture, alarme, 
état d’enregistrement, état d’alarme, état du disque dur, état du réseau, informations système, 
interface de configuration d’interrogation, activer/ désactiver l’OSD, allumer / éteindre 
enregistrement toute la journée, écran partagé (1 écran, 4 écrans, 8 écrans, 9 écrans) et 
quitter le plein écran (entrer en mode menu principal). 
 

 
Figure 5-1 

 

Les icônes et les fonctions spécifiques du menu des raccourcis sont présentées dans le 
tableau 5-1 ci-dessous : 
 

 Icônes Fonctions 

 

Cliquer pour accéder à l’interface d’état de sortie 
des alarmes. (Fonctionnement détaillé dans 5.1.1) 

 

Cliquer pour accéder à l’interface d’état 
d’enregistrement, où l’utilisateur peut afficher l’état 
d’enregistrement du canal, le type de flux, le débit 
binaire et d’autres informations connexes. 

 

Cliquer pour accéder à l’interface d’état de l’alarme, 
où l’utilisateur peut afficher le nom, le type, l’état et 
d’autres informations relatives à chaque canal 
d’entrée d’alarme. 



 

 

  28  

  

 

Cliquer pour accéder à l’interface HDD (disque dur), 
où l’utilisateur peut afficher l’état du disque dur, la 
capacité et d’autres informations connexes. 

 

Cliquer pour accéder à l’interface d’état du réseau, 
où l’utilisateur peut afficher l’adresse IP du 
dispositif, le masque de sous-réseau, la passerelle 
et d’autres informations sur le réseau. 

 

Cliquer dans l’interface d’informations système. 
(Fonctionnement détaillé dans 5.1.2). 

 

Poll (Interrogation) : Cliquer dans l’interface de 
configuration de l’interrogation (Fonctionnement 
détaillé dans 5.1.3) 

 

Activer / désactiver le nom de canal et le numéro de 
canal de chaque canal. 

 

Activer / désactiver l’enregistrement chronométré 
toute la journée pour tous les canaux. 

Fractionnem
ent d’écran 

Le fractionnement d’écran divisera l’écran en 1, 4, 
9, 16, etc. en fonction du nombre de dispositifs pris 
en charge par 
le NVR. 

 

 

Quitter le plein écran, cliquer pour entrer dans le 
mode menu principal. 

Tableau 5-1 
 

REMARQUE 
 À l’heure actuelle, seuls certains équipements de la société prennent en charge la 

correction fisheye. 
 L’affichage multi-écran dépend du nombre maximum de canaux pris en charge par le 

dispositif. Par exemple, il y a 9 écrans dans le menu de raccourcis du dispositif à 9 
canaux et 16 écrans dans le menu de raccourcis du dispositif à 16 canaux. 

 Le NVR 64 canaux prend en charge la prévisualisation vidéo en temps réel du dispositif 
de prévisualisation à double écran, dans laquelle les interfaces HD1 et VGA sont les 
interfaces d’écran principales, et HD2 est l’interface d’écran auxiliaire. Dans l’écran 
principal, l’utilisateur peut configurer le système pour avoir une prévisualisation de la 
vidéo de 64 canaux. Ajouter le canal ajouté à l’écran principal et à l’écran secondaire en 
ajoutant l’interface du dispositif. L’écran secondaire peut ajouter jusqu’à 32 canaux à 
l’écran principal. L’interface de sous-écran prend en charge des fonctions telles que la 
prévisualisation de la vidéo en temps réel, le réglage PTZ, le zoom électronique, le 
réglage de l’image, les informations de flux, l’activation / la désactivation de 
l’enregistrement toute la journée, la commutation du flux principal et du flux secondaire. 

 
5.1.1 État des alarmes 

Cliquer sur «  » dans le menu contextuel pour accéder à l’interface de sortie d’alarme, 
où l’utilisateur peut afficher l’état de sortie d’alarme du dispositif, et l’utilisateur peut 
déclencher / éteindre manuellement la sortie d’alarme, comme illustré sur la Figure 5-2 ci-
dessous : 
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Figure 5-2 

 
5.1.2 Info système 

Cliquer sur «  » dans le menu des raccourcis pour accéder à l’interface des 
informations de version, où l’utilisateur peut afficher le nom du dispositif, le numéro de 
modèle, le nombre de canaux pris en charge par le produit, le numéro de série et d’autres 
informations, comme illustré sur la Figure 5-3 ci-dessous : 
 

 
Figure 5-3 

 
5.1.3 Interrogation 
Le dispositif prend en charge la fonction d'interrogation. Après le réglage, le système lira les 
images vidéo à tour de rôle en fonction de l'écran partagé. Une fois que chaque groupe 
d'images est affiché pendant un certain temps, il passe automatiquement au groupe d'images 
suivant, comme illustré sur la Figure 5-4 :  

Étape 1 : Cliquer sur «  » dans le menu des raccourcis pour accéder à l’interface de 
paramétrage de l’interrogation. 
Étape 2 : Cocher « Enable » (Activer) pour définir l’intervalle et le mode d’interrogation. 
Étape 3 : Cliquer sur « Save » (Sauvegarder). 
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Figure 5-4 

 
 Enable (Activer) : Activer / désactiver la fonction d’interrogation, la valeur par défaut est 

désactivée. 
 Heure(s) : Temps d’interface aller-retour, par défaut 10 secondes. 
 Mode : Le numéro d’écran de l’écran partagé, l’affichage par défaut du canal unique. 
 

5.2 Menu principal 
Cliquer avec le bouton droit de la souris sur l’interface de prévisualisation pour accéder à 
l’interface du menu principal, qui se compose du menu principal (barre de menu supérieure) 
et du menu de raccourcis (barre de menu inférieure). 
Le menu principal comprend Preview (Prévisualisation), Playback (Lecture), File 
management (Gestion des fichiers), Smart (Analyse intelligente), Channel (Canal), Storage 
(Stockage), System (Système) et Maintenance, comme illustré sur la Figure 5-5.  
 

 
 

Figure 5-5 

Les icônes et les fonctions spécifiques du menu principal sont présentées dans le tableau 
5-2 ci-dessous : 

Icônes Fonctions 
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Cliquer pour accéder à l’interface de 
prévisualisation. (Fonctionnement détaillé dans 
5.3.1)  

 

Cliquer pour accéder à l’interface de lecture. 
(Fonctionnement détaillé dans 5.3.2)  

 

Cliquer pour accéder à l’interface de gestion des 
fichiers. (Fonctionnement détaillé dans 5.3.3)  

 

Cliquer pour accéder à l’interface de gestion des 
canaux. (Fonctionnement détaillé dans 5.3.4)  

 

Cliquer pour accéder à l’interface de gestion du 
disque dur. (Fonctionnement détaillé dans 5.3.5)  

 

Cliquer pour accéder à l’interface système. 
(Fonctionnement détaillé dans 5.3.6)  

 

Cliquer pour accéder à l’interface maintenance 
système. (Fonctionnement détaillé dans 5.3.7)  

 

Cliquer pour accéder à l’interface d’informations sur 
les alarmes. (Fonctionnement détaillé dans 5.3.8)  

 

Cliquer pour accéder à l’interface progression de 
sauvegarde. (Fonctionnement détaillé dans 5.3.9)  

 

Cliquer pour accéder à l’interface de déconnexion. 
(Fonctionnement détaillé dans 5.3.10)  

Tableau 5-2 

 
5.3 Fonctionnement 
5.3.1 Prévisualisation 

Dans le menu principal, cliquer sur «  » pour accéder à l’interface de prévisualisation, 
comme illustré sur la 
Figure 5-6 : 
 

 
Figure 5-6 

 
 
 Channel (Canal) : Afficher tous les canaux du système. Double-cliquer sur un canal, et 

l’image en temps réel du canal s’affichera dans la boîte de prévisualisation actuelle 
(boîte rouge). 
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5.3.2 Lecture 
 

5.3.2.1 Vidéo du canal de lecture 

Dans le menu principal, cliquer sur «  » pour accéder à l’interface de lecture vidéo, 
comme illustré sur la Figure 5-7. 
 

 
Figure 5-7 

 

La description de l’interface est fournie dans le tableau suivant : 
 

N° Fonction Description 

1 Canal 

Min / Max Ch : sélectionner intelligemment le 
nombre de canaux de lecture. Min Ch 
sélectionne un canal à la fois par défaut ; Max 
Ch sélectionne à la fois le maximum de 
canaux pris en charge par le dispositif, par 
exemple 4 canaux. 
Channel (Canal) : sélectionner le numéro de 
canal à interroger (plusieurs canaux peuvent 
être sélectionnés en même temps, en fonction 
des performances du dispositif). 

2 Calendrier 

Les dates avec des points de couleur sur le 
calendrier indiquent qu’il y a un enregistrement 
vidéo, et les dates sans points de couleur 
indiquent qu’il n’y a pas d’enregistrement ce 
jour-là. Dans n’importe quel mode de lecture, 
sélectionner le type et le canal 
d’enregistrement, cliquer sur la date à afficher, 
et la chronologie sera mise à jour sur la piste 
d’enregistrement de ce jour. 

3 
Zone de 

contrôle de 
lecture 1 

 : Fichier externe 

 : Lecture par heure 

 : Commuter vers flux principal / 
secondaire 

 : Commuter incrustation point de vente 
(POS) 

/  : Modifier / Quitter modification 
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 : Réglage heure de clip 

: Exporter Clip, sélectionner le fichier du 
clip, puis cliquer sur « OK » pour sauvegarder 
le fichier sélectionné sur la clé USB. 

/  : Décélération / Accélération 

/  : Rembobiner image / Avancer 
image 

 : Vidéo inverse 

/  : lecture/pause 

/  : Page précédente / Page suivante 

/ / /  : Division écran 
1/4/9/16 

 : Lecture en plain écran 

4 
Barre de 
lecture 

Afficher le type et la période d’enregistrement 
dans les conditions actuelles 
Lorsque le dispositif est en mode écrans 
multiples, cliquer sur l’interface de lecture et 
sélectionner un canal. Le premier axe temporel 
est l’axe temporel d’enregistrement du canal 
sélectionné. 
Cliquer avec la souris sur un point dans la 
zone colorée pour démarrer la lecture à partir 
de ce point dans le temps. 

5 
Zone de 

contrôle de 
lecture 2 

/  : Onglet désactivé / activé 
Types de vidéo :  

Toutes : toutes les vidéos 

N : enregistrement normal 

M : enregistrer détection de mouvement 

A : enregistrer alarmes 

M&A : enregistrer détection de 
mouvement et alarme 

I : Enregistrement intelligent 

 : Barre 
de lecture zoom avant / arrière 

6 Masquer menu 

Cliquer sur l’interface de lecture pour faire 
apparaître le menu masqué 

 : Capturer 

 : Activer / désactiver volume 
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 : Zoom électronique 

 : Ajouter des signets, intercepter les 
fichiers de lecture et ajouter 5 secondes avant 
et après l’enregistrement 

 : Fisheye 

 : Fermer menu masqué 

7 
Fenêtre 

d’affichage 

Afficher la vidéo recherchée ; selon les 
systèmes, prend en charge la lecture 
simultanée de 1,4,8,16 écrans. En lecture 
multi-écran, double-cliquer sur un écran pour 
une lecture vidéo sur un seul écran ; clic droit 
ensuite pour retourner à la lecture multi-écran. 

Tableau 5-3 
 

 Playback (Lecture) : Récupérer les fichiers vidéo correspondants en fonction du canal, 
de la date et du type de vidéo, et lire les fichiers vidéo en séquence à partir de la barre 
de lecture qui remplit les conditions. 

 
Les étapes spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur «  » pour accéder à l’interface de lecture. 
Étape 2 : Sélectionner le canal de lecture vidéo et le calendrier affichera automatiquement 
l’enregistrement vidéo du mois en cours. 

 Lecture d’un seul canal 
1. Sélectionner le canal à lire dans la liste des canaux. 
2. Double-cliquer sur la date à lire et l’interface d’affichage commence à lire l’enregistrement, 
comme illustré sur la Figure 5-8 ci-dessous. 
 

 
Figure 5-8 

 
 Lecture de plusieurs canaux 

1. Sélectionner plusieurs canaux à lire dans la liste des canaux. 
2. Double-cliquer sur la date à lire et l’interface d’affichage commence la lecture vidéo 
synchrone de plusieurs canaux, comme illustré sur la Figure 5-9 ci-dessous. 
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Figure 5-9 

REMARQUE 

 La lecture de plusieurs canaux prend en charge la lecture à vitesse MAX. 
 L’interface illustrée sur la Figure 5-7 est fournie à titre indicatif uniquement. Différents 

modèles ont un nombre maximum de canaux différent pour la lecture simultanée et 
des fonctions différentes. Se référer à l’interface réelle. 

 Les informations d’enregistrement du canal peuvent être sélectionnées dans la 
première boîte d’affichage de la barre de progression, et les informations 
d’enregistrement de recherche intelligente du canal peuvent être sélectionnées dans 
la deuxième boîte d’affichage de la barre de progression. 

 
 Lecture des signets 
La fonction lecture des signets peut aider les utilisateurs à enregistrer des informations 
pertinentes à un certain point dans le temps lors de la relecture de vidéos, ce qui leur 
permettra de visualiser à tout moment ces vidéos marquées. 

Étape 1 : Dans le menu principal, cliquer sur «  » pour accéder à l’interface de lecture 
vidéo. 
Étape 2 : Sélectionner le canal pour la lecture vidéo et la date à laquelle la vidéo a été 
enregistrée, et la vidéo recherchée s’affichera sur la barre de progression. 

Étape 3 : Basculer le bouton de signet sur «  ». Après l’ajout d’un signet 
personnalisé, la barre de progression de la lecture affichera un point de repère blanc pour 
indiquer qu’il y a un signet à cette position. 
 

 
Figure 5-10 

REMARQUE 

 Après l’ajout du signet, le système coupera et enregistrera automatiquement la vidéo 
de 5 secondes avant et 5 secondes après l’heure du signet. 
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5.3.2.2 Fonction d’assistance à la lecture 

 Zoom électronique 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur «  » pour accéder à l’interface de lecture 
vidéo. 
Étape 2 : Sélectionner le canal pour la lecture vidéo et la date à laquelle la vidéo a été 
enregistrée, et la vidéo recherchée s’affichera sur la barre de progression. 

Étape 3 : Cliquer sur «  » pour lire sur l’interface d’affichage. 

Étape 4 : Cliquer sur l’interface de lecture, menu popup masqué, cliquer sur «  » 
pour accéder à l’interface Zoom électronique, comme illustré sur la Figure 5-11 ci-dessous. 
 

 

 
Figure 5-11 

 

REMARQUE 

 Entrer dans l’interface zoom électronique, l’image par défaut est agrandie; le 
grossissement maximum de l’image est de 16 fois. 

 Lors de l’agrandissement d’une image, le centre de l’image est agrandi par défaut. 
Maintenir enfoncé le bouton gauche de la souris et faire glisser l’image pour 
sélectionner la zone à agrandir. 

 L’utilisateur peut utiliser la molette de la souris pour effectuer un zoom avant et un 
zoom arrière sur l’image. Tourner la molette de la souris vers le bas pour agrandir 
l’image; tourner vers le haut pour réduire l’image. 

 
 
 Clip 
Cette fonction prend en charge les fichiers vidéo de clip pendant la lecture vidéo. Les étapes 
de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur «  » pour accéder à l’interface de lecture 
vidéo. 
Étape 2 : Sélectionner le canal pour la lecture vidéo et la date à laquelle la vidéo a été 
enregistrée, et la vidéo recherchée s’affichera sur la barre de progression. 

Étape 3 : Cliquer alors sur «  ». Les caractères de début et de fin apparaissent sur la 
barre de progression. L’utilisateur peut les ajuster manuellement pour obtenir la longueur 
désirée du fichier vidéo, comme illustré sur la Figure 5-12 ci-dessous. 
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Figure 5-12 

 

Étape 4 : Cliquer sur «  » pour exporter les clips vers une clé USB, comme illustré 
sur la Figure 5-13 ci-dessous. 
 

 
Figure 5-13 

REMARQUE 

 L’utilisateur peut également cliquer sur «  » pour définir l’heure de début (Start 
Time) et de fin (End Time) du clip afin d’exporter directement le fichier vidéo, comme 
illustré sur la Figure 5-14 ci-dessous. 
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Figure 5-14 

 
 

5.3.3 Gestion des fichiers 
5.3.3.1 All Files (Tous les fichiers) 
Récupération de tous les fichiers. Ici l’utilisateur peut récupérer tous les types de fichiers 
présents dans le périphérique de stockage en fonction des conditions de récupération qu’il 
aura définies et les afficher par catégorie. 

Étape 1 : Dans le menu principal, cliquer sur «  » pour accéder à l’interface de gestion 
des fichiers, comme illustré sur la Figure 5-15. 
 

 
Figure 5-15 

 
Étape 2 : Définir les conditions de recherche (heure, canal, type de fichier, signet et type 
d’événement), cliquer sur « Search » (Rechercher). Les résultats de la recherche afficheront 
les fichiers qui remplissent les conditions, comme illustré sur la Figure 5-16 ci-dessous. 
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Figure 5-16 

 
 Channel (Canal) : Les résultats de la recherche sont affichés groupés par canal. 
 Time (Temps) : Les résultats de la recherche sont affichés groupés par temps. 
 All (Tous) : Les résultats de la recherche affichent les fichiers vidéo et les fichiers image 

qui répondent aux critères. 
 Video (Vidéo) : Les résultats de la recherche affichent uniquement les fichiers vidéo qui 

répondent aux critères. 
 Picture (Image) : Les résultats de la recherche affichent uniquement les fichiers image 

qui répondent aux critères. 
  

  : Afficher les résultats de la recherche par vignettes. 

  : Afficher les résultats de la recherche par liste. 

  : Passer directement à la première page des résultats de recherche. 

  : 1 page en avant 

  : 1 page en arrière 

  : Passer directement à la dernière page des résultats de recherche. 

  : Réduire les résultats de la recherche et retourner à la page des 
conditions de recherche. 

  : Accéder à la page des résultats de recherche pour afficher les 
résultats de la recherche précédente. 

 
Étape 3 : Des opérations connexes telles que la sauvegarde, la visualisation de vidéos ou 
d’images peuvent être effectuées sur les résultats de la récupération. 

 View Video (Afficher vidéo) : Cliquer sur la «  » correspondant au fichier vidéo dans 
le résultat de la recherche pour afficher le clip vidéo. 

 View Picture (Afficher image) : Cliquer sur la «  » correspondant au fichier vidéo 
dans le résultat de la recherche pour afficher les images. 

 
 

 

5.3.3.2 Export 
La fonction de gestion de fichiers prend en charge la sauvegarde de fichiers vidéo et image 
avec un périphérique USB, comme une clé USB ou un disque dur mobile. 
Conditions préalables :  
Le NVR a été correctement connecté au périphérique de stockage de sauvegarde. 
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Étape 1 : Dans le menu principal, cliquer sur «  » pour accéder à l’interface de gestion 
des documents. 
Étape 2 : Définir les conditions de recherche et sélectionner des fichiers vidéo ou image dans 
les résultats de recherche, comme illustré sur la Figure 5-17 ci-dessous. 
 

 
Figure 5-17 

 
Étape 3 : Cliquer sur« Backup → New Folder » (Sauvegarde, Nouveau dossier), saisir le 
nom du fichier et cliquer sur « OK », comme illustré sur la Figure 5-18 ci-dessous. 
 

 
Figure 5-18 

 
Étape 4 : Cliquer sur « OK→OK », lancer la sauvegarde des fichiers dans un nouveau 
dossier de la clé USB. 

Étape 5 : Cliquer sur «  » pour afficher la progression du téléchargement, comme 
illustré sur la Figure 5-19 ci-dessous. 
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Figure 5-19 

REMARQUE 
 Lorsque les fichiers sont sauvegardés, l’utilisateur peut supprimer et mettre en pause les 

fichiers de sauvegarde via «  », «  » et «  ». 
 
5.3.4 Channel (Canal) 
Le canal est composé de paramètres de dispositif et de codage, et permet de gérer caméra, 
POE, OSD, image, PTZ, confidentialité, changement de nom et flux principal / secondaire sur 
le NVR 
 
5.3.4.1 Caméra 
Après avoir ajouté un dispositif, l’utilisateur peut afficher l’écran vidéo du dispositif distant 
directement sur le NVR et effectuer des opérations telles que le stockage et la gestion. 
Différents dispositifs prennent en charge différents nombres de dispositifs distants. 
L’utilisateur peut ajouter les périphériques distants requis en fonction des conditions actuelles.  
Conditions préalables :  
Avant d’ajouter le dispositif, vérifier que la caméra IP a été connectée au réseau sur lequel se 
trouve le NVR et définir correctement ses paramètres réseau. 

REMARQUE 

 Le dispositif peut rencontrer des problèmes de sécurité réseau lorsqu’il est connecté à 
Internet. Renforcer la protection des informations personnelles et la sécurité des 
données. S’il s’avère que le produit peut être soumis à un risque de sécurité du réseau, 
nous contacter en temps opportun. Il est recommandé d’effectuer une évaluation 
périodique de la sécurité réseau du dispositif. Notre société peut fournir des services 
techniques professionnels adaptés. 

 Il est de la responsabilité de l’utilisateur de configurer correctement tous les mots de 
passe et autres paramètres de sécurité associés du produit, et de conserver les noms 
d’utilisateur et les mots de passe en lieu sûr. 

 
 Ajouter un périphérique 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Camera » pour accéder à l’interface 

Camera, comme illustré sur la Figure 5-20 ○1  ci-dessous. 
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Figure 5-20 ○1  

 

Étape 2 : Cliquer sur «  ». Le dispositif recherchera toutes les caméras 
IP du réseau local selon les critères de filtrage « Onvif and Private » (ONVIF et privé) et 

affichera les résultats de la recherche, comme illustré sur la Figure 5-20 ○2  ci-dessous. 

 

Figure 5-20 ○2  

 

  : Cliquer sur l’icône déroulante pour masquer la liste « Search Device » 
(Rechercher un dispositif). 

  : Ajouter la caméra actuelle à la liste des dispositifs. 

  : Supprimer l’IPC actuelle de la liste des dispositifs. 

  : Cliquer pour accéder à l’interface pour modifier l’IP du dispositif, modifier 
l’adresse IP, le port et d’autres informations réseau de la caméra, puis saisir le mot 
de passe de l’administrateur de la caméra et cliquer sur « OK » pour terminer la 
modification. 

 Search (Rechercher) : Rechercher les dispositifs qui remplissent les 
conditions de filtrage sur le réseau local et les afficher dans la liste des dispositifs de 
recherche. 

 Add (Ajouter) : Ajouter un dispositif de sélection au système. 

 Change IP(Modifier IP) : Sélectionner le dispositif dont l’adresse IP doit être 
modifiée, cliquer sur « Change IP » (Modifier IP), saisir « Start IP » (Démarrer IP), 
« Network Mask » (Masque réseau), « Gateway » (Passerelle), « DNS », « Port », « user 
password» (mot de passe utilisateur) et cliquer sur « OK ». L’adresse IP du dispositif 
sélectionné sera modifiée de manière incrémentielle. 

 
 Filtre (Filtre) : Filtrer par type de dispositif de recherche. Les choix de protocole 
possibles sont Onvif, Private, Onvif And Private, Multi Net Segment. 
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Étape 3 : Choisir le dispositif à ajouter, cliquer sur « →  », comme illustré 

sur la Figure 5-20 ○3  ci-dessous. 

 

 

Figure 5-20 ○3  

REMARQUE 

 Cliquer sur «  » dans le coin supérieur droit pour passer à l’affichage de liste, comme 

illustré sur la Figure 5-20 ○4  ci-dessous. 

  

 

Figure 5-20 ○4  

 

 Auto Add (Ajout automatique) : Cliquer sur NVR pour modifier l’IP de caméra et 
tous les autres paramètres réseau du LAN, et le connecter au NVR. 

 Manual Add (Ajout Manuel) : Cliquer pour accéder à l’interface « Channel Setup » 
(Configuration de canal). L’utilisateur peut fermer le canal, basculer, modifier le 
protocole, basculer le flux de code de prévisualisation ou saisir manuellement les 
informations relatives au dispositif pour ajouter le dispositif, comme illustré sur la 

Figure 5-20○5 . Il existe deux méthodes pour ajouter manuellement une adresse IP et un 

nom de domaine. Lors de l’ajout d’IPC via un nom de domaine, seuls les protocoles 
Private et ONVIF sont pris en charge. 
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Figure 5-20 ○5  

 
 Enable (Activer) : Activation/désactivation du canal. Il est désactivé par défaut. 

Cocher « Enable » (Activer) pour que les canaux associée puissent être 
prévisualisés et enregistrés normalement. 

 Channel (Canal) : Sélectionner Set Channel (Définir canal). 
 Add Method (Méthode d’ajout) : Montre la façon dont le canal actuel est ajouté. 
 Protocol (Protocole) : Sélectionner le protocole du dispositif ajouté, avec les 

options Onvif, Private et RTSP. 
 User Name (Nom d’utilisateur) : Le nom d’utilisateur de connexion à l’IPC (si le 

nom d’utilisateur par défaut n’est pas admin, le changer pour qu’il soit un nom 
d’utilisateur valide). 

 Password (Mot de passe) : Le mot de passe de connexion à l’IPC (si le mot de 
passe par défaut n’est pas admin, le changer pour qu’il soit un mot de passe valide). 

 IP : Ajouter l’adresse IP de l’IPC. 
 Domain (Domaine) : Ajouter une adresse de nom de domaine d’IPC, comme une 

adresse factice, une adresse DDNS. 
 Port : Accéder au port utilisé par l’IPC ; la valeur par défaut est 80. 

 Update (Mise à jour) : Sélectionner un ou plusieurs dispositifs de mise à niveau du 
même type, insérer dans le NVR la clé USB sur laquelle est stocké le logiciel de mise à 
niveau du dispositif, cliquer sur « Update » (Mettre à niveau). Le système recherchera le 
logiciel de mise à niveau sur la clé USB et l’affichera. Sélectionner le logiciel de mise à 
niveau, cliquer sur « Upgrade » (Mettre à niveau). Mettre à niveau l’IPC par lots en 
même temps. 

 Delete (Supprimer) : Dans la liste des dispositifs ajoutés, sélectionner le canal à 
supprimer et cliquer sur le bouton « Delete » (Supprimer) pour supprimer tous les 
dispositifs sélectionnés. 

 Enable (Activer) H264+/H265+ : Cliquer pour activer le codage H264+ / H265+ pour 
tous les canaux. Pour désactiver le codage H264+ / H265+, l’utilisateur peut désactiver 
le canal H264+ / H265+ dans l’interface Parameters (Paramètres). 

  : Cliquer et accéder à l’interface de réglage du canal. Cette fonction est la même 
que « Manual Add » (Ajout manuel). 
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  : Supprimer l’IPC actuelle de la liste des dispositifs. 

 Link (Lien) : «  » indique que la connexion est réussie et «  » indique que la 
connexion a échoué. Si la connexion échoue, l’état de la connexion indiquera la cause 
de l’échec. Si le mot de passe est incorrect, le mot de passe utilisateur sera incorrect. 
 

REMARQUE 
 Une IPC ne peut être ajouté qu’une seule fois par le NVR. 
 Lorsque des adresses IP sont modifiées par lots, veiller à ce que le nom d’utilisateur et le 

mot de passe de tous les dispositifs sélectionnés soient identiques. 
 Si des adresses IP sont modifiées par lots et si des adresses IP sont en conflit, le 

système ignore automatiquement les adresses IP en conflit et les redéfinit de manière 
incrémentielle. 

 Après avoir modifié les adresses IP par lots, rechercher à nouveau le dispositif distant. 
La nouvelle adresse IP sera affichée dans la liste. 

 Après avoir sélectionné un dispositif pour ajouter un bouton, tous les dispositifs 
réattribueront l’adresse IP. Utiliser REMARQUE. 

 Le mode Ajout peut être réglé sur « Manual » (Manuel) ou « Plug and play » dans le 
NVR POE, lequel n’est pas réglable dans le NVR normal.  

 Avant d’utiliser la fonction de mise à niveau, copier le logiciel de mise à niveau 
correspondant au dispositif à mettre à niveau sur une clé USB et insérer celle-ci dans le 
NVR. 

 Lorsque plusieurs dispositifs IP doivent être mis à niveau, il n’est possible de 
sélectionner que le même dispositif IP. Pendant la mise à niveau, tous les dispositifs IP 
ne peuvent pas être mis hors tension. Sinon, la mise à niveau échoue ou le dispositif ne 
peut pas démarrer. 

 

5.3.4.2 POE- POUR NVR UNIQUEMENT 
POE est utilisé pour afficher et définir l’alimentation de chaque canal POE du NVR. Il se 
compose de la configuration d’alimentation PoE et de la configuration de liaison PoE. 
 Configuration de l’alimentation PoE  
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « → POE → PoE Power Configuration » 
(Configuration de l’alimentation PoE) pour accéder à l’interface de configuration de 
l’alimentation PoE, comme illustré sur la Figure 5-21 ci-dessous. 
 

 
Figure 5-21 

 
Étape 2 : Vérifier l’état de la connexion et la consommation d’énergie de chaque port de 
POE, et choisir « long distance » ou « short distance » (longue distance ou courte distance) 
en fonction de la distance de connexion réelle. 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
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 PoE Bonding Configuration (POUR NVR UNIQUEMENT) 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « → POE → PoE Bonding Configuration » 
(Configuration de liaison PoE) pour accéder à l’interface PoE Bonding Configuration, comme 
illustré sur la Figure 5-22 ci-dessous. 
 

 
Figure 5-22 

 
Étape 2 : Sélectionner le canal lié et définir le canal sur lequel le dispositif est alimenté par 
POE. 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 
5.3.4.3 OSD 
 
OSD est l’abréviation de « On Screen Display ». L’OSD de prévisualisation locale comprend 
principalement l’heure et le nom du canal. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →OSD » pour accéder à l’interface de 
réglage OSD, comme illustré sur la Figure 5-23 ci-dessous. 
 

 
Figure 5-23 

 
Étape 2 : Sélectionner le canal pour définir l’OSD. 
Étape 3 : Définir l’OSD du canal. 

REMARQUE  
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 OSD comprend les options Channel name, Time, Text, Date format, OSD position and 
Mirror (nom du canal, heure, texte, format de date, position OSD et miroir). 

 La fonction OSD actuelle ne prend en charge que le protocole privé pour ajouter le 
dispositif à obtenir et à définir. 

 
Étape 4 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 

 
 
5.3.4.4 Image 
Dans l’interface Image Color (Couleur de l’image), les options Brightness (luminosité), 
Contrast, Saturation et Sharpness (netteté) de la vidéo du canal IP peuvent être ajustées. Les 
paramètres associés pour l’IPC peuvent également être définis, tels que Fill light (lumière 
d’appoint), Exposure setting (réglage d’exposition), Backlight setting (réglage du contre-jour), 
White balance (balance des blancs), Video adjustment (réglage vidéo), Image enhancement 
(amélioration de l’image). 
 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Image » pour accéder à l’interface de 
configuration de l’image, comme illustré sur la Figure 5-24 ci-dessous. 
 

 
Figure 5-24 

 
Étape 2 : Sélectionner le canal pour la configuration de l’image. 
Étape 3 : Ajuster les paramètres d’image du canal. 
 

REMARQUE 
 L’utilisateur peut faire glisser le curseur pour ajuster les paramètres. 
 Les options de réglage de l’image qui peuvent être ajustées sont Fill light (lumière 

d’appoint), Exposure setting (réglage d’exposition), Backlight setting (réglage du contre-
jour), White balance (balance des blancs), Video adjustment (réglage vidéo), Image 
enhancement (amélioration de l’image) et Defog mode (Mode désembuage). 

 Le réglage des paramètres de la vidéo ne changera pas seulement l’effet de 
prévisualisation de l’image, mais également la qualité vidéo de l’image. Consulter la 
REMARQUE. 

 
Étape 4 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 

 
 Image adjustment (Réglage de l’image) : Selon l’environnement réel, l’utilisateur peut 

régler la luminosité, le contraste, la saturation et la netteté de l’écran de prévisualisation 
en faisant glisser la barre de progression. L’utilisateur peut également définir la valeur 
derrière la barre de progression, « Brightness » (Luminosité), « Contrast », 
« Saturation », « Sharpness » (Netteté). Les valeurs valides sont comprises entre 0 et 
255 et la valeur par défaut est 128. 
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 Fill light (Lumière d’appoint) : Par défaut, le mode est « Auto » (automatique), la 
sensibilité est de 3, le temps de filtrage est de 3, la luminosité est de 100. Lorsque Fill 
light (Lumière d’appoint) est en mode est « Auto », le dispositif allume la lumière 
d’appoint en fonction de l’environnement actuel. L’utilisateur peut basculer le mode 
d’appoint sur « Day » (Jour), « Night » (Nuit) et « Scheduled switch » (Commutation 
programmée) en fonction de la scène vidéo réelle de la scène, et changer la sensibilité 
et le temps de filtrage du dispositif en fonction du mode de remplissage. Lorsque le 
mode d’éclairage d’appoint est « Scheduled switch » (Commutation programmée), 
l’utilisateur peut régler l’heure de lumière du jour et d’obscurité (c’est-à-dire l’heure de 
début et de fin de remplissage), ainsi que la luminosité de la lumière d’appoint. 
 Lorsque le mode d’appoint est « Day » (Jour), la vidéo du moniteur du dispositif est 

ajoutée à l’effet jour. 
 Lorsque le mode d’appoint est « Night » (Nuit), la vidéo du moniteur du dispositif est 

patché en un effet de nuit. 
 Filtering time (Temps de filtrage) : Il est utilisé pour empêcher la lumière ambiante 

de s’améliorer et la lumière est fréquemment allumée et éteinte, et le temps de 
filtrage est réglé. Pendant cette période, la caméra n’est pas perturbée par la 
lumière ambiante. 

 Light brightness (Luminosité de l’éclairage) : Cette option permet de régler la 
luminosité de la lumière d’appoint. La plage de réglage est de 0 à 100. 

 Exposure Settings (Réglages d’exposition) : La valeur par défaut est Auto, qui change 
le mode manuel en fonction des besoins du moment. Lorsque « Manual » (Manuel) est 
sélectionné, la durée d’exposition et la commande de gain sont activées. 

 Backlight (Contre-jour) : Cette option permet de régler la compensation du contre-jour 
et la suppression de forte intensité lumineuse. La valeur par défaut est Off (désactivée). 
Elle peut être activée manuellement et le contre-jour est réglable. 

 White balance (Balance des blancs) : La valeur par défaut est Auto et peut être 
commutée sur « Manual » (Manuelle).  
 Manual white balance (Balance des blancs manuelle) : Prend en charge le gain 

R, V, B réglable. La plage de réglage est (0-255). Cliquer sur « Save » 
(Sauvegarder) après le réglage. 

 Video Adjustment (Réglage vidéo) : Ici, l’utilisateur peut activer et définir la réduction 
de bruit numérique 2D ou 3D. 

 Image Enhancement (Amélioration Image) : Permet à l’utilisateur de sélectionner le 
mode de contrôle du scintillement, d’activer et régler l’intensité dynamique large. 
 Flicker control (Contrôle du papillotement) : Le mode Flicker control est 

sélectionné en fonction de l’environnement d’installation de la caméra IPC et de la 
norme de papillotement. La norme PAL est 50 Hz et la norme NTSC est 60 Hz. 
Lorsque le dispositif est installé à l’extérieur, il peut être sélectionné à l’extérieur. Le 
paramètre par défaut est PAL. 

 Sensor linear WDR (Capteur linéaire WDR) : La valeur par défaut est 
« Shutdown » (Fermeture). L’utilisateur peut changer la force dynamique large dans 
le menu déroulant. Les options sont Automatic, Weak, Moderate, Strong, Super 
(Automatique, Faible, Modérée, Forte, Super). 

 Defog Mode (Mode désembuage) : Utilisé pour régler le mode de désembuage et la 
force. 
 Defog Mode (Mode désembuage) : La valeur par défaut est Off (désactivé) et 

l’utilisateur peut sélectionner On (Activé) ou Auto (Automatique) dans le menu 
déroulant. 

 Defog strength (Intensité du désembuage) : La valeur par défaut est 0. Lorsque 
le mode de désembuage est activé, l’intensité de désembuage peut être réglée. La 
plage des valeurs possibles est de 0 à 255. 

 
 

REMARQUE  
 L’interface d’image de la caméra affiche uniquement les fonctions de prise en charge du 

dispositif. L’interface spécifique dépend du produit réel. 
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5.3.4,5 PTZ 

Sur la page de menu, cliquer sur « →PTZ » pour accéder à l’interface de réglage PTZ, 

comme illustré sur la Figure 5-25 ○1  ci-dessous. Dans l’interface de configuration PTZ, 

d’autres canaux peuvent être commutés pour régler la vitesse du mouvement 
panoramique/inclinaison et contrôler le sens du mouvement panoramique/inclinaison. 

 

 

Figure 5-25 ○1  

 
L’interface de configuration PTZ permet de définir la direction PTZ, la vitesse et le zoom de 
l’objectif, les paramètres de mise au point et d’ouverture et le bouton de raccourci des 
paramètres de tour. 
 Channel (Canal) : Sélectionner le canal par lequel la caméra dôme est connectée au 

NVR. 

 Zoom : Ajuster le grossissement de la caméra à l’aide de la touche  / , fonction 
longue portée / grand angle. 

 (Focus) Mise au point : Utiliser la touche  / , la fonction zoom avant / zoom 
arrière, ajuster la caméra pour faire la mise au point. 

 Iris (Diaphragme) : Utiliser la touche  / , la fonction zoom avant / zoom arrière, 
pour ajuster l’ouverture de la caméra. 

 Speed (Vitesse) : Cette fonction est principalement utilisée pour régler le 
fonctionnement de la vitesse de rotation panoramique/inclinaison. Par exemple, la 
vitesse de rotation par pas de 7 est nettement supérieure à la vitesse de rotation par pas 
de 1. 

 Réglage de présélection : Utiliser le bouton de direction pour tourner le PTZ vers 
l’emplacement souhaité, puis cliquer sur le bouton de présélection sous le bouton 
« Set » pour terminer les réglages du point de présélection. 

 Réglage des tours : Après avoir sélectionné la ligne de tour (cruise line), cliquer sur le 
bouton de réglage, sélectionner le numéro de Preset (présélection), le Stay Time (temps 
de maintien, en secondes) et la Cruise speed (vitesse de tour) dans l’interface pop-up de 

réglage de la ligne de tour, comme illustré sur la Figure 5-25 ○2 . Cliquer sur le bouton 

« OK ». Retourner à l’écran des paramètres de tour et cliquer à nouveau sur « Cruise 
on » (Tour activé) pour enregistrer les réglages et faire démarrer le dispositif en mode 
tour. 
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Figure 5-25 ○2  

 
 Preset No. (N° de présélection) : Permet de sélectionner des points de 

présélection. 
 Stay Time (Temps de maintien) : Temps de maintien sur la présélection. 
 Speed (Vitesse) : Vitesse du tour. 

 Cruise on (Tour activé) : Après que l’utilisateur a cliqué sur cette option, le dispositif 
passe en mode tour et suit l’itinéraire de tour sélectionné. 

 Del Cruise (Suppr tour) : Sélectionner la ligne de tour, cliquer sur « Del Cruise », et 
renseigner la ligne de tour à supprimer. 

 Del All Cruise (Suppr tous les tours) : Permet de supprimer toutes les lignes de tour 
définies. 

REMARQUE 
 Le NVR prend en charge jusqu’à 256 points de présélection, mais le nombre réel de 

positions de présélection est limité par le nombre de points de présélection pouvant être 
définis par la caméra. Le nombre maximum de points de présélection pris en charge par 
différents PTZ n’est pas nécessairement le même.  

 Certains NVR prennent en charge le réglage des paramètres de dôme ou pan/tilt 
(panoramique/inclinaison) pour les canaux analogiques. Avant de contrôler le dôme ou 
pan/tilt (panoramique/inclinaison), vérifier que la ligne de commande RS-485 entre le 
décodeur pan/tilt et l’enregistreur vidéo à disque dur est correctement connectée, et 
configurer les paramètres du décodeur pan/tilt dans le dispositif. 

Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →PTZ » pour accéder à l’interface de 

configuration PTZ, comme illustré sur la Figure 5-25○3  ci-dessous. 
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Figure 5-25 ○3  

 
Étape 2 : Sélectionner le canal où se trouve la caméra PTZ, cliquer sur « PTZ parameter 
setting » (Réglage des paramètres PTZ) pour accéder à l’interface de réglage des 

paramètres PTZ, comme illustré sur la Figure 5-25○4 . 

 

 

Figure 5-25 ○4  

 
Étape 3 : Définir les paramètres pertinents (protocole, débit en bauds, bit de données, bit 
d’arrêt, bit de parité, etc.) de la caméra connectée selon les besoins, et cliquer sur 
« Confirm » (Confirmer) pour terminer. 
 Channel (Canal) : Sélectionner pour accéder au canal de la caméra avec la fonction 

pan/tilt (panoramique/inclinaison). 
 Protocol (Protocole) : Sélectionner le protocole pan/tilt de la marque et le modèle du 

dispositif d’accès (si le canal est connecté à un pan/tilt réseau, sélectionner « Private », 
si le canal est connecté à un pan/tilt RS485, sélectionner d’autres options). 

 Baud Rate (Débit en bauds) : Sélectionner le débit en bauds utilisé pour accéder au 
PTZ afin de contrôler le PTZ et la caméra du canal correspondant. La valeur par défaut 
est 2400. 

 Data Bit (Bit de données) : La valeur par défaut utilisée est 8. 
 Stop Bit (Bit d’arrêt) : La valeur par défaut utilisée est 2. 
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 Check (Vérification) : La valeur par défaut est EVEN (Paire). 
 Address (0-255) : Définir l’adresse pour accéder à PTZ. La valeur par défaut est 0. 
 

REMARQUE 
 Les PTZ Parameters Settings (Réglages des paramètres PTZ) permettent de définir la 

caméra PTZ ajoutée au canal analogique. Tous les paramètres (protocole, adresse, débit 
en bauds, bit de données, bit d’arrêt, bit de parité) doivent être cohérents avec les 
paramètres du décodeur PTZ. 

 
5.3.4.6 Privacy Mask (Masque de confidentialité) 

La fonction masque de confidentialité peut bloquer certaines zones sensibles ou liées à 
la confidentialité dans l’image de la scène de surveillance. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Privacy Mask » pour accéder à 

l’interface Privacy Mask, comme illustré sur la Figure 5-26○1  ci-dessous. 

 

 

Figure 5-26 ○1  

 
Étape 2 : Sélectionner le canal pour l’occlusion vidéo. 
Étape 3 : Utiliser la souris pour définir la zone d’occlusion dans la vidéo, comme illustré 

sur la Figure 5-26 ○2  ci-dessous. 

 

 

Figure 5-26 ○2  
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Étape 4 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 Channel (Canal) : Sélectionner Set Channel (Définir canal). 
 Clear All (Suppr Tout) : Permet d’effacer tous les masques de zones sélectionnées. 
 Clear Zoom1, 2, 3 (Suppr Zoom 1, 2, 3) : Permet d’effacer la zone d’occlusion 

sélectionnée 1, 2, 3. 

REMARQUE 
 Il est possible de définir jusqu’à 3 zones d’occlusion. Cliquer sur Clear Zone X (Effacer 

zone X) pour supprimer la définition de cette zone. 
 

5.3.4.7 Channel Name (Nom de canal) 

 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Channel name » pour accéder à 
l’interface Channel name (Nom de canal), comme illustré sur la Figure 5-27 ci-dessous. 
 

 
Figure 5-27 

 
Étape 2 : Sélectionner le canal à définir, modifier le nom du canal. 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 

5.3.4.8 Main Stream (Flux principal) (pour NVR uniquement) 
 

L’interface Main Stream (Flux principal) est utilisée pour enregistrer la 
configuration des paramètres. Les étapes de fonctionnement spécifiques sont les 
suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Main Stream » (Flux principal) 
pour accéder à l’interface Main Stream, comme illustré sur la Figure 5-28 ci-dessous. 
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Figure 5-28 

 
Étape 2 : Régler les paramètres d’enregistrement. Se référer au Tableau 5-4 pour la 
description de paramètres spécifiques. 
 

Nom Détails Réglage 

Channel 
(Canal) 

Sélectionner le canal pour définir 
les paramètres d’enregistrement. 

Sélectionner dans la 
liste déroulante.  

Record Set 
(Enregistrem

ent défini) 

Il existe deux types de paramètres 
de compression vidéo : Main 
Stream (timing) [Flux principal 
(synchronisation)] et Main Stream 
(Event) [Flux principal 
(événement)]. 
Main Stream (timing) : 
Paramètres de codage pour 
enregistrement ordinaire. 
Main Stream (Event) : paramètres 
de codage pour les événements 
tels que la détection de 
mouvement, l’entrée d’alarme et 
la détection intelligente 

REMARQUE :  
Les paramètres 
d’événement ne 
peuvent pas être définis 
et sont cohérents avec 
les paramètres de 
synchronisation. 

Resolution 
(Résolution) 

La résolution fait référence au 
nombre de pixels contenus dans 
une unité de longueur. 

Sélectionner dans la 
liste déroulante.  
REMARQUE :  
La résolution du codage 
est liée au dispositif IP. 

Stream Type 
(Type de flux) 

Le type de flux est Vidéo et audio 
(flux composite) et les 
informations d’enregistrement 
comprennent la vidéo et l’audio. 

Sélectionner dans la 
liste déroulante.  

Bitrate Type 
(Type débit 

binaire) 

Le mode de flux de code est 
divisé en débit de code variable et 
débit de code constant. 
Variable bit rate (Débit binaire 
variable) : Le débit binaire 
changera en fonction de la scène. 
Constant bit rate (Débit binaire 
constant) : Le débit binaire doit 
être codé en fonction de la limite 
supérieure du débit binaire et la 
qualité vidéo ne peut pas être 
ajustée. 

Sélectionner dans la 
liste déroulante.  
REMARQUE :  
Le type de débit binaire 
est lié au dispositif IP. 
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Frame Rate 
(Fréquence 
d’images) 

La fréquence d’images vidéo fait 
référence au nombre d’images 
vidéo par seconde. 

Ajuster à l’aide du 
curseur.  

Bitrate(Kb/S) 
(Débit binaire 

[ko/s]) 

Définir la valeur du flux de code 
pour modifier la qualité de l’image. 
Plus la valeur est élevée, 
meilleure est la qualité de l’image. 

Modifier directement 
dans la zone de saisie. 

Bitrate Range 
(Plage de 

débit binaire) 
6000-12000 (ko/s)   

Video 
Encoding 
(Codage 
vidéo) 

H264, H265 

Sélectionner dans la 
liste déroulante.  
REMARQUE :  
Le type de codage est 
lié au dispositif IP. 

H265+ 
Enable/Disable 
(Activer/Désactiver) 

 

Tableau 5-4 
 

Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 

 

5.3.4.9 Sub Stream (Flux secondaire) (POUR NVR UNIQUEMENT)）  

Les paramètres de flux secondaire sont utilisés pour la transmission réseau. Lorsque 
l’environnement réseau est médiocre, les utilisateurs peuvent utiliser le flux secondaire 
pour la prévisualisation du réseau afin de réduire la bande passante de transmission, et 
le flux secondaire est également utilisé pour la surveillance des téléphones mobiles. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Sub Stream » (Flux secondaire) 
pour accéder à l’interface Sub Stream, comme illustré sur la Figure 5-29 ci-dessous. 
 

 
Figure 5-29 

 
Étape 2 : Régler les paramètres d’enregistrement. Se référer au Tableau 5-5 pour la 
description de paramètres spécifiques. 
 

Nom Détails Réglage 

Channel 
(Canal) 

Sélectionner le canal pour définir 
les paramètres d’enregistrement. 

Sélectionner dans la 
liste déroulante.  

Resolution 
(Résolution) 

La résolution fait référence au 
nombre de pixels contenus dans 
une unité de longueur. 

Sélectionner dans la 
liste déroulante.  
REMARQUE :  
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La résolution du codage 
est liée au dispositif IP. 

Stream Type 
(Type de flux) 

Le type de flux est Vidéo et audio 
(flux composite) et les 
informations d’enregistrement 
comprennent la vidéo et l’audio. 

Sélectionner dans la 
liste déroulante.  

Bitrate Type 
(Type débit 

binaire) 

Le mode de flux de code est 
divisé en débit de code variable et 
débit de code constant. 
Variable bit rate (Débit binaire 
variable) : Le débit binaire 
changera en fonction de la scène. 
Constant bit rate (Débit binaire 
constant) : Le débit binaire doit 
être codé en fonction de la limite 
supérieure du débit binaire et la 
qualité vidéo ne peut pas être 
ajustée. 

Sélectionner dans la 
liste déroulante.  
REMARQUE :  
Le type de débit binaire 
est lié au dispositif IP. 

Frame Rate 
(Fréquence 
d’images) 

La fréquence d’images vidéo fait 
référence au nombre d’images 
vidéo par seconde. 

Ajuster à l’aide du 
curseur.  

Bitrate(Kb/S) 
(Débit binaire 

[ko/s]) 

Définir la valeur du flux de code 
pour modifier la qualité de l’image. 
Plus la valeur est élevée, 
meilleure est la qualité de l’image. 

Modifier directement 
dans la zone de saisie. 

Bitrate Range 
(Plage de 

débit binaire) 
512-853 (ko/s)   

Video 
Encoding 
(Codage 
vidéo) 

H264, H265 

Sélectionner dans la 
liste déroulante.  
REMARQUE :  
Le type de codage est 
lié au dispositif IP. 

Tableau 5-5 
 

Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 

5.3.4.10 Record Stream (Flux d’enregistrement) (POUR NVR 

UNIQUEMENT)） 
 

Interface de flux vidéo pour la configuration des paramètres vidéo. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Record Stream » (Flux 
d’enregistrement) pour accéder à l’interface Record Stream, comme illustré sur la 
Figure 5-30 ci-dessous. 
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Figure 5-30 

 
Étape 2 : Régler les paramètres d’enregistrement. Se référer au Tableau 5-6 pour la 
description de paramètres spécifiques. 
 

Nom Détails Réglage 

Channel 
(Canal) 

Sélectionner le canal pour définir 
les paramètres d’enregistrement. 

Sélectionner dans la 
liste déroulante.  

Video 
Encoding 
(Codage 
vidéo) 

H264, H265 
Sélectionner dans la 
liste déroulante.  

H264+/H265
+ 

Enable/Disable 
(Activer/Désactiver) 

Sélectionner dans la 
liste déroulante.  
REMARQUE :  
Le type de codage est 
lié au dispositif IP. 

Encode Level 
(Niveau de 

codage) 

Permet d’afficher le niveau de 
codage de la caméra ou de la 
caméra dôme 

Pas de réglages 

Preview 
Information 

(Informations 
de 

prévisualisati
on) 

Permet d’afficher la résolution de 
prévisualisation de la caméra ou 
de la caméra dôme 

Pas de réglages 

Audio 
Encoding 
(Codage 
audio) 

Sélection de la méthode de codage 
audio. Le dispositif prend en charge 
les options G711U, G711A, AAC. 

Sélectionner dans la 
liste déroulante.  

Watermark 
Enable 
(Activer 
filigrane) 

Activer désactiver. 
Sélectionner dans la 
liste déroulante.  

Watermark 
String 

(Chaîne 
filigrane) 

Cliquer pour saisir le contenu du 
filigrane. 
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Resolution 
(Résolution) 

La résolution fait référence au 
nombre de pixels contenus dans 
une unité de longueur. 

Sélectionner dans la 
liste déroulante.  
REMARQUE :  
La résolution du codage 
est liée au dispositif IP. 

Stream Type 
(Type de flux) 

Le type de flux est Vidéo et audio 
(flux composite) et les 
informations d’enregistrement 
comprennent la vidéo et l’audio. 

Sélectionner dans la 
liste déroulante.  

Bitrate Type 
(Type débit 

binaire) 

Le mode de flux de code est 
divisé en débit de code variable et 
débit de code constant. 
Variable bit rate (Débit binaire 
variable) : Le débit binaire 
changera en fonction de la scène. 
Constant bit rate (Débit binaire 
constant) : Le débit binaire doit 
être codé en fonction de la limite 
supérieure du débit binaire et la 
qualité vidéo ne peut pas être 
ajustée. 

Sélectionner dans la 
liste déroulante.  
REMARQUE :  
Le type de débit binaire 
est lié au dispositif IP. 

I-Frame 
Interval 

(Intervalle 
d’image I) 

Permet d’afficher l’intervalle 
image principal de la caméra ou 
de la caméra dôme 

Ajuster à l’aide du 
curseur.  

Quality 
(Qualité) 

Permet de définir la qualité 
d’image du canal analogique 

Sélectionner dans la 
liste déroulante.  

Frame Rate 
(Fréquence 
d’images) 

La fréquence d’images vidéo fait 
référence au nombre d’images 
vidéo par seconde. 

Ajuster à l’aide du 
curseur.  

Bitrate(Kb/S) 
(Débit binaire 

[ko/s]) 

Définir la valeur du flux de code 
pour modifier la qualité de l’image. 
Plus la valeur est élevée, 
meilleure est la qualité de l’image. 

Modifier directement 
dans la zone de saisie. 

Tableau 5-4 
 

Étape 3 : Cliquer sur « Apply » (Appliquer) pour enregistrer la configuration. 
 

REMARQUE 

 Chaque élément de configuration de cette interface dépend du modèle spécifique du 
dispositif connecté au canal. Se référer au dispositif réel. 

 
 
 
5.3.5 Stockage 
Le stockage comprend les options suivantes : Record (enregistrement), Storage Device 
(dispositif de stockage), Storage Mode (mode de stockage), Auto Backup (sauvegarde 
automatique) et Advanced (avancé). 
5.3.5.1 Record (Enregistrement) 
Le NVR prend en charge deux plans d’enregistrement, une méthode de dessin et une 
méthode de modification. 
 Définir le plan d’enregistrement par la méthode de dessin 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Record » (Enregistrement) pour 

accéder à l’interface de configuration Record, comme illustré sur la Figure 5-31 ○1  ci-

dessous. 
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Figure 5-31 ○1  

 
Étape 2 : Selon les besoins d’enregistrement, activer, sélectionner le canal, le type 
d’enregistrement (Normal, Mouvement, Alarme, M&A, Intelligent), la semaine et d’autres 
options 
Étape 3 : Cliquer avec le bouton gauche de la souris pour localiser le point de départ de la 
zone de dessin, faire glisser la souris pour déterminer l’heure du plan d’enregistrement, relâcher 
le bouton gauche de la souris pour enregistrer en tant que plan d’enregistrement, comme 

illustré sur la Figure 5-31 ○2  ci-dessous. 

 

 

Figure 5-31 ○2  

 
Étape 4 : Répéter les étapes 3 pour configurer un plan d’enregistrement complet. 
Étape 5 : Une fois le plan d’enregistrement défini, le canal présente le type (couleur) du plan 

d’enregistrement, comme illustré sur la Figure 5-31 ○3  ci-dessous. 
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Figure 5-31 ○3  

REMARQUE 
 Il y a 6 périodes de temps disponibles pour chaque jour, et le dispositif commencera le 

type d’enregistrement correspondant dans la plage de temps définie. 
 La plus petite unité de la zone de dessin est 1 heure. 
 Sélectionner « All » (Tout) pour modifier la période de toute la semaine. 

 L’utilisateur peut sélectionner le «  » devant plusieurs jours d’une semaine à la fois, 
modifier simultanément les jours sélectionnés et dessiner la période. 

 Dans la même période, la vidéo de détection de mouvement et la vidéo de M&A 
(mouvement et alarme) ne peuvent choisir qu’une option. 
 

 Définir le plan d’enregistrement par la méthode de modification 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Record » (Enregistrement) pour 
accéder à l’interface de configuration d’enregistrement. 
Étape 2 : Cliquer sur « Edit » (Modifier) pour accéder à l’interface de réglage « Record 

Schedule » (Planification d’enregistrement), comme illustré sur la Figure 5-31 ○4  ci-dessous. 

 

 

Figure 5-31 ○4  

 
Étape 3 : Sélectionner le « recording type » (type d’enregistrement) de chaque période. Il y a 
six périodes de temps de réglage pour chaque jour. Sélectionner la semaine correspondante 
dans « Apply » (Appliquer) pour appliquer à cette semaine. 
Étape 4 : Cliquer sur « Save » (Sauvegarder) pour terminer le paramétrage, le système 
retournera à l’interface « Record » (Enregistrer). 
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 Channel (Canal) : Commencer par sélectionner le groupe de canaux. Pour définir tous 

les canaux, sélectionner « All » (Tous). 
 Type Enreg (Type d’enregistrement) : Cocher la case pour sélectionner le type 

d’enregistrement correspondant. Les options sont Normal, Motion (Mouvement), Alarm, 
M&A (Mouvement et alarme), Intelligent. 

 Week day (Jour de la semaine) : Sélectionner le nombre de semaines. Si vous 
sélectionner «All» (Tous), cela signifie pour toute la semaine, ou l’utilisateur peut 

sélectionner «  » devant le nom des jours pour définir des jours individuels.  
 More Settings (Plus de réglages) : L’utilisateur peut définir des pré-enregistrements et 

des post-enregistrements, comme illustré sur la Figure 5-31 ○5  ci-dessous. 

  

 

Figure 5-31 ○5  

 
 Copy (Copier) : Une fois la configuration terminée, l’utilisateur peut cliquer sur le bouton 

« Copy » (Copier) pour copier la configuration actuelle sur d’autres canaux,, comme 

illustré sur la Figure 5-31 ○6 . 

  

 

Figure 5-31○6  
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5.3.6.2  Storage Device (Dispositif de stockage) 
Le dispositif de stockage est utilisé pour formater le disque dur et afficher l’état et la capacité 
applicables du disque dur. 
 Formatage du disque dur 
Conditions préalables :  
L’utilisateur doit avoir correctement installé le disque dur. Pour plus de détails sur la 
procédure d’installation du disque dur, se référer au « Guide de démarrage rapide du NVR ». 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Storage Device » (Dispositif de 

stockage) pour accéder à l’interface Storage Device, comme illustré sur la Figure 5-32 ○1  ci-

dessous. 
 

 

Figure 5-32 ○1  

 
Étape 2 : Sélectionner le disque dur à formater, cliquer sur « Format → Confirm » (Formater, 

Confirmer), comme illustré sur la Figure 5-32 ○2  ci-dessous. 

 

 

Figure 5-32 ○2  

 
Étape 3 : Attendre que la barre de progrès du formatage soit terminée, cliquer sur 
« Confirm » (Confirmer). Le NVR redémarrera et terminera le formatage. L’état du disque dur 
est alors « In Use » (En cours d’utilisation). 

 
 No. (Nombre) : Le nombre de disques durs qui se connectent au système. 
 State (État) : Détecter l’état de fonctionnement en cours du disque dur. Seul celui dont 

l’état affiché est « In Use » (En cours d’utilisation) est utilisable. Une fois le formatage 
terminé, redémarrer le NVR. L’état affiché est alors « In Use » (En cours d’utilisation). 

 Total Capacity (Capacité totale) : La capacité totale du disque dur disponible. La 
capacité du disque dur unique ne peut pas dépasser la capacité maximale : 8 To. 

 Residual Capacity (Capacité résiduelle) : Afficher la capacité résiduelle du disque dur 
actuel. 
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 Device Type (type dispositif) : SATA. 
 Refresh (Rafraîchir) : Cliquer sur cette option pour mettre à jour la liste des informations 

du disque. 

REMARQUE 
 « No Disk » (Pas de disque) indique que le dispositif n’est pas connecté ou que le disque 

dur n’est pas détecté. 
 Le disque dur doit être formaté lorsqu’il est connecté au NVR pour la première fois ou 

lorsque « Not formatted » (Non formaté) s’affiche. 
 Le dispositif n’a pas besoin de formater le disque dur lorsque l’état du disque dur indique 

« In Use » (En cours d’utilisation). 
 Après avoir formaté le disque dur, redémarrer le NVR pour que le formatage prenne 

effet. 
 

 
5.3.7 Système 
5.3.7.1 Général 
Dans l’interface « General », l’utilisateur peut afficher et définir la langue du NVR, le mode 
d’enregistrement, les jours d’enregistrement, les normes vidéo, l’heure de veille et les 
paramètres de date. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →General » pour accéder à l’interface 
de configuration General, comme illustré sur la Figure 5-33 ci-dessous. 
 

 
Figure 5-33 

 
Étape 2 : Régler la langue, le fuseau horaire, le mode d’enregistrement, les jours 
d’enregistrement et d’autres informations du dispositif selon les besoins. 
 Language (Langue) : Définir la langue par défaut du système. Prend actuellement en 

charge le chinois simplifié, le chinois traditionnel, l’anglais, le polonais, le tchèque, le 
russe, le thaï, l’hébreu, le bulgare, l’arabe, l’allemand, le français, le portugais, le turc, 
l’espagnol, l’italien, le hongrois, le romain, le coréen, le néerlandais, le grec, le 
vietnamien et le japonais. La valeur par défaut est l’anglais. 

 Time Zone (Fuseau horaire) : Sélectionner le fuseau horaire du dispositif dans la liste 
déroulante. Par exemple : Pékin est GMT+8:00. 

 Date/Time (Date/Heure) : Cliquer sur cette option pour modifier les informations. Un 
clavier virtuel apparaît. Saisir la date et l’heure via ce clavier. 

 Record Mode (Mode d’enregistrement) : Pour « Overwrite » (Écraser), lorsque le 
disque sera plein, il écrasera automatiquement la vidéo la plus ancienne. Si le disque 
n’est pas plein, mais que le nombre de jours vidéo atteint le paramètre utilisateur, la 
vidéo la plus ancienne sera automatiquement écrasée. 

 Record Days (Jours d’enregistrement) : Définir le nombre de jours pour le stockage 
des enregistrements NVR. Le menu déroulant offre les options No Limit, 30, 15, 7, 6, 5, 
4, 3, 2, 1. 
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 Device Name (Nom du dispositif) : Renseigner le nom du positif en fonction des 
besoins réels. La valeur par défaut est NVR. 

 Mouse Pointer Speed (Vitesse du pointeur de la souris) : Permet de régler la vitesse 
de déplacement de la souris. Plus la valeur est élevée, plus la réponse de la souris est 
rapide, et plus la valeur est petite, plus la réponse de la souris est lente. Les choix 
possibles sont 0 à 5. 

 Auto Login (Connexion Auto) : La valeur par défaut est « désactivée ». Si l’option est 
cochée, le NVR se connecte automatiquement au système dès qu’il est mis sous 
tension. 

 Auto Log Out (Déconnexion automatique) : La valeur par défaut est 10 minutes. Les 
choix possibles sont les suivants : 1 Minute, 2 Minutes, 5 Minutes, 10 Minutes, 20 
Minutes, 30 Minutes, 60 Minutes et Never (Jamais). « Never » équivaut à un état de 
veille permanent. 

 Fullscreen Time(sec) [Temps plein écran (s)] : Cette option permet de régler la durée 
d’affichage en plein écran de la liaison d’alarme. La valeur par défaut est de 10 
secondes, et elle peut être définie à 5 secondes, 10 secondes, 15 secondes et 20 
secondes. 

 Enable Wizard (Activer assistant) : Cliquer sur «  », ouvrir l’assistant de démarrage, 
puis accéder directement à l’interface « Startup Wizard » (Assistant de démarrage) à 
chaque mise en route. 

 Date Format (Format de date) : Sélectionner le format d’affichage de la date : « Day 
Month Year » (Jour Mois Année), « Month Day Year » (Mois Jour Année) ou « Year 
Month Day » (Année Mois Jour). 

 Time Format (Format d’heure) : Choisir un format 24 heures ou 12 heures. 
 Separator (Séparateur) : Sélectionner le séparateur du format de date. 

 Enable DST (Activer DST) : Cocher «  », ouvrir la fonction « daylight saving time » 
(heure d’été), définir les paramètres pertinents, tels que Type, Date, Start Time (Heure 
de début), End Time (Heure de fin), etc. 

 Type : Réglage de l’heure d’été. 
 Start Time (Heure de début) : L’heure de début de l’heure d’été. 
 End Time (Heure de fin) : L’heure de fin de l’heure d’été. 
 Offset(min) (Décalage) : Le décalage pour l’heure d’été. 
 Channel Check Time (Heure de vérification du canal) : Sélectionner le canal dont 

l’heure doit être vérifiée, définir l’intervalle de mise à jour et cliquer sur « Save » 
(Sauvegarder) pour définir l’heure du canal de manière à ce qu’elle corresponde à 
l’heure du NVR. 

 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 
5.3.7.2 Channel Config (Configuration du canal) (POUR NVR UNIQUEMENT) 
Différents modèles de dispositif prennent en charge différents nombres de canaux IP. Le 
dispositif prend en charge l’augmentation du nombre de canaux IP en désactivant les canaux 
analogiques. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Channel Config » pour accéder à 
l’interface Channel Config (Configuration des canaux), comme illustré sur la Figure 5-34. 
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Figure 5-34 

 
Étape 2 : Vérifier le type d’accès au canal sur demande. Lorsque le canal est connecté à la 
caméra analogique, sélectionner « HD », lorsque le canal est connecté à la caméra réseau, 
sélectionner « IP ». 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour enregistrer la configuration. 
 
 Lite mode (Mode Lite) : 

 Activer mode LITE : accès maximum à 5M_12.5fps, 4M_15fps, 3M_18fps et 1080P, 
codage de support maximum 1080N 25fps en cas d’accès à 1080P. 

 Désactiver mode LITE : accès maximum à 8M_15fps.5M_20fps, 4M_30fps, 
3M_30fps et 1080P, codage de support maximum 1080P 15fps en cas d’accès à 
1080P. 

REMARQUE 

 Lors de la sélection du mode de connexion de signal pour un seul canal, l’utilisateur 
doit suivre certaines règles. L’interface reflétera automatiquement les options 
conformément aux règles. 

 Le signal d’accès réel doit correspondre au mode de signal vérifié. Si le mode « HD 
» est sélectionné pour un canal, celui-ci peut être connecté aux signaux 
TVI/CVBS/AHD/CVI. Lorsque le signal de commutation provoque l’affichage d’une 
anomalie, le câble vidéo peut être reconnecté. Si le canal est sélectionné en mode 
« IP », alors c’est un canal IP et un dispositif IP peut être connecté. 
 

5.3.7.3 TCP/IP 
Network (Réseau) offre les options TCP/IP, Address Filter (Filtre d’adresse), Cloud Storage 
(Stockage Cloud) et Advanced (Avancés). 
 TCP/IP 
TCP/IP offre les options TCP/IP, DDNS, PPPOE, NTP, FTP et UPNP, comme illustré sur la 
Figure 5-35 ci-dessous. 
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Figure 5-35 

 
 TCP/IP 

Définir l’adresse IP, le serveur DNS et d’autres informations du dispositif NVR pour assurer 
que celui-ci peut communiquer avec d’autres dispositifs du réseau. 

REMARQUE 
 Si le dispositif est utilisé pour la surveillance du réseau, le réseau doit être configuré pour 

une utilisation normale. 
 Factory default IP (IP d’usine par défaut) : 192.168.1,111 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →TCP/IP→TCP/IP » pour accéder à 
TCP/IP pour définir l’interface, comme illustré sur la Figure 5-36 ci-dessous. 
 

 
Figure 5-36 

 
Étape 2 : ConFigure IP Address (Adresse IP), Network Mask (Masque réseau), Gateway 
(Passerelle), Primary DNS (DNS principal) et les autres paramètres réseau associés. 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage.  

 IP Address (Adresse IP) : Entrer l’adresse IP du NVR. 
 Enable DHCP (Activer DHCP) : Activer/désactiver la fonction DHCP (Dynamic Host 

Configuration Protocol). « IP Address », « Network Mask » et « Gateway » ne peuvent 
être définis lorsque DHCP est activé.  

 Network Mask (Masque réseau) : Selon la situation réelle définie. 
 Gateway (Passerelle) : Selon la situation réelle définie, avec l’adresse IP dans le même 

segment de réseau. 
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 Primary DNS (DNS principal) : Il s’agit de l’adresse IP du serveur DNS, qui est 
généralement fournie par le fournisseur d’accès à Internet (FAI) local. Saisir ici l’adresse 
IP de votre serveur de noms de domaine. 

 Secondary DNS (DNS secondaire) : Démarrer le DNS secondaire lorsque le DNS 
principal ne fonctionne pas. 

 MAC Address (Adresse MAC) : Affiche l’adresse physique du NVR. 
 TCP Port (port TCP) : La valeur par défaut est 5000, selon les besoins réels des 

utilisateurs de définir le port. 
 Http Port (port HTTP) : La valeur par défaut est 80, selon les besoins réels des 

utilisateurs de définir le port.  
 RTSP Port (port RTSP) : La valeur par défaut est 554, selon les besoins réels des 

utilisateurs de définir le port. 
 Private Port (Port privé) : La valeur par défaut est 6000, selon les besoins réels des 

utilisateurs de définir le port. 
 Network Rate (Fréquence réseau) : Affiche la fréquence de transmission du réseau. 
 Internal Net Card IP (IP de la carte réseau interne) : Définir l’adresse IP intranet pour 

connecter le périphérique POE du dispositif. 
 Refresh (Rafraîchir) : Cliquer pour actualiser l’interface. 

 REMARQUE 
 L’adresse IP et la passerelle par défaut doivent être dans le même segment de réseau. 
 Si le DHCP activé par NVR est activé et que l’utilisateur désactive DHCP, il n’est plus 

possible d’afficher les informations IP d’origine. Il faut réinitialiser l’adresse IP et les 
autres paramètres. 

 Seuls les dispositifs compatibles PoE ont une fonction de carte réseau interne. Se 
référer au produit réel. 

 L’adresse IP de la carte réseau interne et l’adresse IP du NVR ne peuvent pas être sur le 
même segment de réseau. 

 
 DDNS 

Une fois le paramètre DDNS (Dynamic Domain Name Server) défini, lorsque l’adresse IP du 
dispositif NVR change fréquemment, le système peut mettre à jour dynamiquement la relation 
entre le nom de domaine et l’adresse IP sur le serveur DNS. L’utilisateur peut utiliser le nom 
de domaine pour accéder directement au NVR sans enregistrer l’adresse IP qui change 
constamment. 
Conditions préalables 
Avant de configurer DDNS, s’assurer que le dispositif prend en charge le type de serveur de 
résolution de nom de domaine et se connecter au site Web du fournisseur de services DDNS 
pour enregistrer le nom d’utilisateur, le mot de passe, le nom de domaine et d’autres 
informations sur le PC WAN. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Sur la page de menu, cliquer sur « →CP/IP →DDNS » pour accéder à 
l’interface DDNS, comme illustré sur la Figure 5-37. 
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Figure 5-37 

Étape 2 : Activer DDNS, sélectionner le type de DDNS et entrer la durée d’actualisation (en 
secondes), le nom d’utilisateur et le mot de passe. 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour enregistrer le réglage du DDNS. 
Étape 4 : Entrer le nom de domaine dans le navigateur Web du PC et appuyer sur 
« Entrée ». Si l’interface Web du dispositif s’affiche, la configuration est réussie. Dans le cas 
contraire, la configuration a échoué. 
 Enable DDNS (Activer DDNS) : Activation de la fonction de résolution de domaine 

DDNS. 
 DDNS Type (Type DDNS) : Sélectionner le type DDNS par serveur de résolution de nom 

de domaine dynamique. (À l’heure actuelle, le dispositif prend en charge plusieurs 
DDNS, y compris ORAY, NO-IP. Ces multiples DDNS peuvent coexister en même temps, 
et l’utilisateur peut les sélectionner et les définir selon ses besoins.) 

 Refresh Time (Sec) [Temps d’actualisation (s)] : Ne pas rafraîchir fréquemment. 
L’intervalle entre deux rafraîchissements doit être supérieur à 60 secondes. Des 
demandes de rafraîchissement trop nombreuses peuvent entraîner des attaques du 
serveur. 

 User Name (Nom d’utilisateur) : Le compte enregistré auprès du fournisseur de 
services DNS. 

 Password (Mot de passe) : Le mot de passe enregistré auprès du fournisseur de 
services DNS. 

 Domain (Domaine) : Le nom de domaine enregistré auprès du fournisseur de services 
DNS. 

REMARQUE 
 Après avoir configuré le DDNS, s’assurer que le NVR est connecté au WAN pour 

accéder au dispositif via le nom de domaine DDNS. 
 

 

 PPPoE 
PPPoE (Point-to-Point Protocol over Ethernet) est l’un des moyens par lesquels les dispositifs 
XVR accèdent au réseau. Après avoir obtenu le nom d’utilisateur et le mot de passe PPPoE 
fournis par le fournisseur d’accès Internet, il est possible d’établir une connexion réseau via 
une connexion PPPoE. Une fois la connexion établie, le dispositif XVR obtient 
automatiquement une adresse IP dynamique du WAN. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →TCP/IP→PPPOE » pour accéder à 
PPPOE pour définir l’interface, comme illustré sur la Figure 5-38 ci-dessous. 
 

 
Figure 5-38 

 
Étape 2 : Sélectionner « Enable » (Activer), saisir le nom d’utilisateur et le mot de passe du 
PPPoE. 
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Étape 3 : Cliquer sur « Apply » (Appliquer) pour enregistrer la configuration. 
 Enable (Activer) : Activer/Désactiver la fonction PPPOE du dispositif. 
 User Name (Nom d’utilisateur) : Le nom d’utilisateur PPPOE fourni par le FAI 

(Fournisseur d’accès Internet). 
 Password (Mot de passe) : Le mot de passe correspondant au nom d’utilisateur. 

REMARQUE 
 Une fois le paramétrage réussi, l’utilisateur peut vérifier l’état du PPPOE à partir de 

«  Maintenance → Network » (Réseau). 
 Le réglage terminé, le dispositif composera automatiquement le numéro après le 

redémarrage. Une fois la connexion réussie, les informations sur le réseau peuvent être 
affichées dans l’état du réseau et les utilisateurs peuvent accéder au dispositif via 
l’adresse IP. 

 Une fois la configuration terminée, l’adresse IP de l’interface TCP/IP ne peut plus être 
modifiée. 

 
 NTP 

Après avoir activé NTP (Network Time Protocol), le système peut ajuster périodiquement 
l’heure du dispositif via le serveur NTP pour garantir l’exactitude de l’heure système du 
dispositif. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →TCP/IP→NTP » pour accéder à NTP 
pour définir l’interface, comme illustré sur la Figure 5-39 ci-dessous. 
 

 
Figure 5-39 

 
  Étape 2 : Choisir « Enable NTP » (Activer NTP) pour définir les paramètres liés à 

NTP. 
 NTP Server (Serveur NTP) : Sélectionner le nom de domaine du serveur sur lequel le 

service NTP est installé. 
 Custom (Personnalisé) : Lorsque le serveur NTP sélectionne « Custom » 

(Personnalisé), saisir manuellement le nom de domaine du serveur NTP. 
 NTP Port (Port NTP) : Sélectionner le port correspondant au serveur NTP. 
 Interval (Min) (Intervalle) : Intervalle de correction de l’heure NTP. La valeur par défaut 

est de 720 minutes et la plage réglable est de 30 à 1440 minutes. 
 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 

 FTP 
Avec le serveur FTP (File Transfer Protocol), l’utilisateur peut stocker des images d’alarme 
sur le serveur FTP. 
Conditions préalables 
Il faut acheter ou télécharger l’outil de service FTP et installer le logiciel sur votre PC. 
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REMARQUE 
 Pour créer un utilisateur FTP, il faut définir l’autorisation d’écriture sur le dossier FTP. 

Sinon, l’image ne sera pas téléchargée. 
 

Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Sur la page de menu, cliquer sur «  → Network → FTP » pour accéder à 
l’interface FTP, comme illustré sur la Figure 5-40. 
 

 
Figure 5-40 

 
Étape 2 : Sélectionner « Enable FTP » (Activer FTP) et entrer des paramètres tels que FTP 
Server (Serveur FTP), FTP Port (Port FTP), User Name (Nom d’utilisateur), Password (Mot 
de passe) et le File Upload path (chemin de téléchargement de fichier). 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour enregistrer la configuration. 
Étape 4 : Cliquer sur « Test » pour déterminer si la connexion réseau et la configuration FTP 
sont correctes. 

REMARQUE 
 Si le test échoue, revérifier le réseau ou la configuration FTP. 
 
 Enable FTP (Activer FTP) : Activer/Désactiver la fonction FTP du dispositif. 
 FTP Server (Serveur FTP) : Adresse IP hôte du serveur FTP. 
 FTP Port (Port FTP) : Le port FTP par défaut est 21. Si votre serveur FTP est différent; 

utiliser le même nom de port avec votre serveur FT. 
 User Name (Nom d’utilisateur) : Saisir le nom d’utilisateur pour se connecter au 

serveur FTP. 
 Password (Mot de passe) : Saisir ici le mot de passe correspondant. 
 File Upload (Téléchargement fichiers) : Créer des dossiers selon les règles dans le 

répertoire du compte FTP. 
 Lorsque le répertoire distant est vide, le système enregistre l’image téléchargée 

dans le répertoire racine du serveur FTP. 
 Entrer le nom du répertoire distant. Le système créera un dossier avec le nom 

correspondant sous le répertoire racine FTP et enregistrera les images téléchargées 
dans ce dossier. 

 Channel (Canal) : Sélectionner le canal pour télécharger le fichier de capture. 
 Week (semaine) : Sélectionner l’heure de téléchargement du fichier FTP en fonction de 

la semaine. L’utilisateur peut définir deux périodes par semaine. 
 Time period 1& 2 (Périodes 1 et 2) : Définir la période de temps pour le téléchargement 

des fichiers FTP dans une journée. 
 Test : Cliquer sur « Test » pour déterminer si le NVR peut télécharger des fichiers sur le 

serveur FTP. 
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 UPNP 
Une fois la cartographie entre le réseau interne et le réseau externe établie via le protocole 
UPnP, l’utilisateur du réseau externe peut utiliser l’adresse IP du réseau externe pour accéder 
directement au dispositif NVR sur l’intranet. 
Conditions préalables 
1) Se connecter au routeur et définir l’adresse IP du port WAN du routeur pour accéder au 
réseau externe. 
2) Veiller à ce que le routeur soit un routeur de premier niveau (ou un routeur virtuel de 
premier niveau) et activer la fonction UPnP. 
3) Connecter le dispositif au port LAN du routeur et accéder au réseau privé. 

4) Dans le menu principal, sélectionner « → TCP/IP → IP/Port », définir « Adresse IP » 
comme IP privée du routeur (par exemple : 192.168.1.101) ou sélectionner « DHCP » pour 
obtenir l’adresse IP automatiquement. 
 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Sur la page de menu, cliquer sur «  → TCP/IP → UPnP » pour accéder à 
l’interface UPnP, comme illustré sur la Figure 5-41. 
 

 
Figure 5-41 

 
Étape 2 : Activer la fonction UPnP et configurer les paramètres associés tels que l’adresse IP 
interne, l’adresse IP externe et les informations de cartographie de port de la route UPnP. 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour enregistrer la configuration. 
 
 Enable (Activer) : Activer/Désactiver la fonction UPnP du dispositif. 
 Status (Statut) : Affiche l’état de cartographie de UPnP. 
 Internal IP (IP interne) : Entrer l’adresse du port LAN du routeur. Une fois la 

cartographie réussie, l’adresse IP sera automatiquement obtenue sans réglage. 
 External IP (IP externe) : Entrer l’adresse du port WAN du routeur. Une fois la 

cartographie réussie, l’adresse IP sera automatiquement obtenue sans réglage. 
 Port Mapping Table (Table de cartographie du port) : Cela correspond aux 

informations de la table de cartographie UPnP sur le routeur. 
 Servername (Nom de serveur) : Nom du serveur WEB. 
 Protocol (Protocole) : Le type d’accord. 
 Internal Port (Port interne) : Le port que la machine locale doit cartographier. 
 External Port (Port externe) : Le port cartographié sur le routeur. 

 Add (Ajouter) : Cliquer sur « Add » (Ajouter) pour augmenter la cartographie, entrer le 
nom du service, le port interne et le port externe. 

 Server Name (Nom du serveur) : Saisir le nom du service et le définir soi-même. 
 Internal Port (Port interne) : L'utilisateur doit entrer le port HTTP, le port RTSP et le port 

TCP correspondants. 
 External Port (Port externe) : Peut être auto-défini. Le port interne peut être le même, 

mais ne peut pas être répété, pas plus que d’autres ports NVR. 
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 Delete (Supprimer) : Sélectionner les informations de mappage dans la table de 
mappage de port et supprimer la relation de mappage. 

 

REMARQUE 
 Lors de la configuration du port externe du port de cartographie du routeur, essayer 

d’utiliser un port entre 1024 et 65535. S’abstenir d’utiliser le port bien connu 1~255 et le 
port système 256~1023 pour éviter les conflits. 

 Lors du déploiement de plusieurs dispositifs dans le même réseau local, planifier la 
cartographie des ports de façon à éviter de cartographier plusieurs dispositifs sur le 
même port externe. 

 Lors de la cartographie des ports, s’assurer que le port cartographié n’est pas occupé ou 
restreint. 

 Les ports TCP internes et externes doivent être cohérents et ne peuvent pas être 
modifiés. 

 
 Address Filter (Filtre d’adresses) : 
La liste noire et la liste blanche empêchent le PC de se connecter au client Web du NVR en 
filtrant l’adresse IP ou l’adresse MAC. Il existe deux types: la liste noire et la liste blanche. 
 Blacklist (Liste noire) :  

1. NVR ne peut pas se connecter à l’adresse IP ou à l’adresse MAC d’une IPC dans 
la liste noire. 
2. Un ordinateur dont l’adresse IP ou MAC Figure dans la liste noire ne pourra pas 
se connecter à la page Web du NVR. 

 Whitelist (Liste blanche) :  
1. Le dispositif ne peut se connecter qu’à une caméra IP (IPC) figurant dans la liste 

blanche. 
2. Seules les IPC de la liste blanche peuvent accéder au NVR. 

Les étapes d’utilisation de listes noires / listes blanches sont expliquées ci-
dessous : 

Étape 1 : Dans le menu principal, choisir « →Address Filter » (Filtre d’adresses) pour 
accéder à l’interface de réglage Address Filter, comme illustré sur la Figure 5-42 ci-dessous. 
 

 
Figure 5-42 

 
Étape 2 : Choisir « Restriction Type » (Type de restriction), tel que « Blacklist » (Liste noire). 
Étape 3 : Cliquer sur « Add » (Ajouter), choisir l’adresse IP (ou l’adresse MAC), saisir 
l’adresse IP. 
Étape 4 : Cliquer sur « Apply » (Appliquer). L’adresse IP ou l’adresse MAC sera ajoutée à la 
liste noire du dispositif. 
 
Étapes de filtrage des adresses IP et des adresses MAC :  
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Étape 1 : Dans le menu principal, choisir « →Address Filter » (Filtre d’adresses) pour 
accéder à l’interface de réglage Address Filter. 
Étape 2 : Choisir « Enable→ Restriction type » (Activer, Type de restriction). 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage.  
 Enable (Activer) : Activer/désactiver la fonction de filtrage du NVR. 
 Restriction Type (Type de restriction) : Il existe deux options : « Blacklist » (Liste 

noire) et « Whitelist » (Liste blanche). 
 Restriction List (Liste de restriction) : Correspondant à la liste de la liste de types 

actuellement sélectionnés, affiche toutes les adresses IP, adresses MAC et statuts 
(Activer/Désactiver) ajoutés dans la liste. 

 Add (Ajouter) : Permet d’ajouter liste noire et liste blanche. 

 Delete (Supprimer) : Permet de supprimer la liste sélectionnée dans la liste de 
filtres. 

 Delete All (Supprimer tous) : Permet de supprimer des listes dans la liste de filtres. 

ATTENTION 

 Le dispositif prend en charge l’ajout de 128 listes blanches et 128 listes noires maximum. 
 Double-cliquer sur une liste dans la liste de filtres pour accéder à l’interface d’ajout. 

L’utilisateur peut modifier l’adresse IP ou l’adresse MAC. 
 Lors d’ajouts à la liste noire ou à la liste blanche, les lettres de l’adresse MAC peuvent 

être des majuscules ou des minuscules et sont séparées par « : », par exemple « 00: bb: 
f2: 00 : 15 »". 

 Lorsque le type de restriction IP est Liste noire/Liste blanche, une seule liste est en 
vigueur à la fois. 

 
 Stockage sur le Cloud 
 Google 
Définir le stockage sur le cloud. Lorsque le dispositif déclenche une alarme, il peut stocker 
l’image d’alarme capturée du dispositif sur le serveur cloud. 
Conditions préalables 
1) L’utilisateur doit disposer d’un compte Dropbox ou Google Cloud Storage. 
2) Avec cette fonction, le dispositif doit être connecté à un réseau externe, sinon cela ne 
fonctionnera pas correctement. 
 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Sur la page du menu principal, cliquer sur « →Cloud Storage→Google » pour 
accéder à l’interface Google setting (Réglage Google), comme illustré sur la Figure 5-43. 
 

 
Figure 5-43 
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Étape 2 : Sélectionner « Enable → Google » pour obtenir le « Authorization Code » (Code 
d’autorisation). Suivre les instructions pour se connecter au site Web sur l’ordinateur et entrer 
le code d’autorisation pour se connecter au service cloud du serveur Google. 
Étape 3 : Cliquer sur « Apply » (Appliquer). 
Étape 4 : Cliquer sur « Test » pour déterminer si le NVR peut télécharger des fichiers sur le 
serveur cloud. Une fois la liaison réussie, l’interface de stockage dans le cloud affiche le nom 
d’utilisateur « Google », la capacité totale et l’espace utilisé. 
 
 Enable (Activer) : Activer/Désactiver la fonction « Cloud storage » du dispositif. 
 Google : Sélectionner un type de stockage cloud et accéder à l’interface de liaison. 
 Upload Folder (Dossier de téléchargement) : Définir le nom du dossier de 

téléchargement de l’espace cloud. 
 Username (Nom d’utilisateur) : Affiche le nom d’utilisateur Google. 
 Capacity (Capacité) : Une fois la liaison de stockage cloud réussie, la capacité totale de 

l’espace cloud s’affiche. 
 Used (Utilisé) : La liaison de stockage dans le cloud a réussi ; la capacité utilisée de 

l’espace cloud s’affiche. 
 Test : Après la liaison, cliquer sur « Test » pour vérifier si la liaison est réussie. Si le test 

échoue, vérifier que le dispositif est correctement connecté au réseau et vérifier la 
configuration de stockage dans le cloud. 

 
 Advanced (Avancés) : 
 E-mail 
Après avoir défini les informations de courrier électronique et activé la fonction de courrier 
électronique de liaison d’alarme, lorsque le NVR déclenchera une alarme, le système enverra 
un courrier électronique d’alarme à la boîte aux lettres de l’utilisateur. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Sur la page du menu principal, cliquer sur « → Advanced→ E-mail » pour 
accéder à l’interface E-mail setting (Réglage E-mail), comme illustré sur la Figure 5-44. 
 

 
Figure 5-44 

 
Étape 2 : Activer les notifications d’alarme par e-mail, configurer le serveur SMTP, le port 
SMTP, le nom d’utilisateur, le mot de passe, l’expéditeur, l’objet, l’intervalle des messages, et 
sélectionner le type de cryptage, le fichier joint et d’autres paramètres. 
Étape 3 : Cliquer sur « E-mail test » et le message « Success. Check the inbox. » (Réussi. 
Vérifier boîte de réception) s’affiche. Alors la configuration de la messagerie est réussie. Si le 
message « E-mail can’t be delivered! » (Envoi d’e-mail impossible) s’affiche, la configuration 
de la messagerie a échoué. 
Étape 4 : Une fois l’e-mail envoyé avec succès, cliquer sur « Apply » (Appliquer) pour 
enregistrer la configuration de la messagerie. 

 
 Enable Email (Activer e-mail) : Activer/désactiver l’envoi d’e-mails. 
 SMTP Server (Serveur SMTP) : Sélectionner le type de serveur SMTP. 
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 SMTP Port (Port SMTP) : Saisir ici la valeur de port correspondante. 
 User Name (Nom d’utilisateur) : Saisir le nom d’utilisateur pour se connecter à la boîte 

e-mail de l’expéditeur. 
 Password (Mot de passe) : Saisir ici le mot de passe correspondant. 
 Sender (Expéditeur) : Saisir ici la boîte e-mail de l’expéditeur. 
 Recipient 1/2/3 (Destinataire 1/2/3) : Adresse e-mail du destinataire 1/2/3. 
 Subject (Objet) : Saisir ici l’objet de l’e-mail. Le système prend en charge les caractères 

latins et les nombres arabes. Par défaut, l’objet est « XNVR_ALERT ». 
 Message Interval (Min) (Intervalle des messages) : Intervalle entre les envois d’e-

mails. Une fois l’intervalle d’envoi des e-mails défini, lorsque l’alarme est déclenchée, le 
système ne déclenche pas l’envoi immédiat de l’e-mail en fonction du signal d’alarme. Au 
lieu de cela, l’e-mail est envoyé en fonction de l’intervalle de temps du même type d’e-
mail d’événement. Cela permet d’éviter les alarmes fréquentes et l’envoi d’e-mails trop 
nombreux, qui entraîneraient une surcharge du serveur de messagerie. La plage de 
temps est comprise entre 0 et 600 minutes. 0 minute signifie que le courrier est envoyé 
sans attendre. 

 Encryption (Cryptage) : Sélectionner le cryptage du serveur de boîtes aux lettres. Les 
options sont NONE (Aucun), SSL, TLS et « SSL » par défaut. 

 Attach File (Joindre fichier) : Activer/désactiver la fonction de pièce jointe à l’e-mail. 
Une fois l’alarme activée, le système peut envoyer des instantanés lorsque l’alarme est 
envoyée. 

 Week (semaine) : Sélectionner l’heure d’envoi des e-mails en fonction de la semaine. 
L’utilisateur peut définir deux périodes par jour. 

 Time period 1& 2 (Périodes 1 et 2) : Définir la plage horaire d’envoi des e-mails. Après 
réglage, les messages d’alarme sont envoyés pendant ces périodes. Pas d’envois d’e-
mail à d’autres moments. 

 Enable Auto Email (Activer e-mail automatique) : Activer/désactiver l’envoi 
automatique d’e-mails. 

 Email Interval (Min) (Intervalle des e-mails) : Intervalle d’envoi des e-mails. 
 E-mail Test (Test e-mail) : Permet de tester que les fonctions d’envoi et de réception 

d’e-mails fonctionnement normalement. Si la configuration est correcte, la boîte de 
réception recevra un e-mail de test. Si le test échoue, vérifier les paramètres ou le statut 
du réseau. 

 
 P2P 
P2P est une technologie de pénétration de réseau privé. Il n’est pas nécessaire de demander 
un nom de domaine dynamique, d’effectuer une cartographie de port ni de déployer un 
serveur de transit. L’utilisateur peut scanner directement le code QR pour télécharger un 
client mobile. Après avoir enregistré un compte, l’utilisateur peut ajouter et gérer 
simultanément plusieurs dispositifs IPC, NVR, XVR sur le client mobile. 
Il est possible d’ajouter des dispositifs des deux manières suivantes pour en gérer plusieurs. 
1) Scanner le QR code du système de téléphonie mobile, télécharger l’application et 
enregistrer le compte. Pour plus de détails, consulter le manuel d’utilisation de l’application 
sur le site Web. 
2) Se connecter à la plate-forme P2P, créer un compte et ajouter le dispositif en indiquant son 
numéro de série. 

REMARQUE 
 Avec cette fonction, le dispositif doit être connecté à un réseau externe, sinon cela ne 

fonctionnera pas correctement. 
 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Sur la page de menu, cliquer sur «  → Advanced→ P2P » pour accéder à 
l’interface P2P, comme illustré sur la Figure 5-45. 
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Figure 5-45 

 
Step2 : Veiller à ce que le NVR accède au réseau externe, choisir « Enable P2P→ 
Encryption » (Activer P2P → Cryptage). 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour enregistrer la configuration. 
Étape 4 : Cliquer sur « Refresh » (Actualiser) et l’état affiche « Online » (En ligne). Cela 
indique que le P2P est activé et peut être utilisé normalement. 
 
 Status (Statut) : Afficher l’état P2P en ligne du dispositif. 
 Enable P2P (Activer P2P) : Activer/désactiver la fonction P2P du dispositif. La valeur 

par défaut est « Online » (En ligne). 
 Channel Number (Nombre de canaux) : Affiche l’utilisateur actuel visualisant le nombre 

de vidéos de canal NVR sur l’application client. 
 Encryption (Cryptage) : Sélectionner le type de cryptage. Une fois le dispositif activé, 

toutes les communications de signalisation entre le dispositif et le serveur sont cryptées. 
 Push Interval (min) (Intervalle de poussée) : Définir l’intervalle de temps pendant 

lequel le dispositif doit capturer l’image d’alarme à destination du client mobile, et 
l’utilisateur peut également sélectionner « Turn off the push » (Désactiver la poussée) 
pour empêcher le dispositif de pousser l’image vers le terminal mobile. 

 SN (NS) : Affiche le numéro de série du dispositif P2P. Ce numéro de série est unique. 
 Refresh (Rafraîchir) : Permet d’actualiser les informations relatives à l’interface P2P. 
 
 
5.3.7.4 Setting (Réglage) 
L’interface Setting comprend deux options : User et Holiday. 
 User (Utilisateur) 

REMARQUE 
 Le nom d’utilisateur d’administrateur par défaut défini en usine est admin et le mot de 

passe est admin. 
 Les administrateurs peuvent ajouter et supprimer des utilisateurs et configurer les 

paramètres utilisateur. 
 Le niveau utilisateur comporte deux niveaux : opérateur et utilisateur général.  
 

ATTENTION 

 Afin d’améliorer la sécurité du réseau du produit, mettre à jour régulièrement le mot de 
passe du produit. Il est recommandé de mettre à jour le mot de passe tous les 3 mois. Si 
l’environnement du produit est soumis à des exigences de sécurité strictes, il est 
recommandé de mettre à jour le mot de passe une fois par mois ou par semaine. 

 Il est recommandé aux administrateurs de gérer efficacement les comptes de dispositif et 
les autorisations des utilisateurs, de supprimer les utilisateurs et autorisations non 
pertinents et de fermer les ports réseau inutiles. 
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 Les administrateurs doivent configurer les droits des utilisateurs de manière appropriée 
et recommander l’utilisation de noms d’utilisateur personnalisés pour la gestion de la 
maintenance quotidienne. 

 
 
 Add User (Ajouter utilisateur) 
 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →User » pour accéder à l’interface User, 

comme illustré sur la Figure 5-46 ○1  ci-dessous. 

 

 

Figure 5-46 ○1  

 
 User list (Liste d’utilisateurs) : Affiche tous les utilisateurs actuels du dispositif ; 

l’administrateur ne peut modifier que son mot de passe, pas ses autorisations. 
 

Étape 2 : Cliquer sur « Add » (Ajouter) pour accéder à l’interface Confirm (Confirmer 

autorisation). Confirmer d’abord le mot de passe, comme illustré sur la Figure 5-46 ○2  ci-

dessous. 
 

 

Figure 5-46○2  
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Étape 3 : Entrer le mot de passe administrateur, cliquer sur « OK ». Une fois l’autorisation 
confirmée, l’utilisateur peut accéder à l’interface d’ajout d’utilisateur, comme illustré sur la 

Figure 5-46 ○3  ci-dessous. 

 

 

Figure 5-46 ○3  

 
Étape 4 : Entrer les nouvelles informations utilisateur (nom d’utilisateur, mot de passe, 
confirmer le mot de passe), sélectionner le niveau, cliquer sur « Save » (Sauvegarder). 
Étape 5 : Définir les autorisations. 

Sélectionner l’utilisateur ajouté avec succès, cliquer sur le bouton «  » correspondant sous 
l’autorisation pour accéder à l’interface d’autorisation, et définir l’autorisation utilisateur. 
 
 Description de Authority 
 
Authority se divise en configuration locale, configuration à distance, configuration de canal. 
Les utilisateurs administrateurs peuvent activer/désactiver les autorisations correspondantes 
selon les besoins. 
 Local Config (Configuration locale) 

 Configuration des paramètres locaux : définir les paramètres, restaurer les 
paramètres par défaut, importer/exporter les paramètres. 

 Configuration du canal local : Ajouter, supprimer, modifier, importer et exporter des 
fichiers de configuration pour le canal IP.  

 Utilisateur local : Vérifier l’interface de gestion des utilisateurs. 
 Disque local : Afficher et définir les plans d’enregistrement, formater les dispositifs 

de stockage. 
 Journal local : Afficher les journaux système, les informations système. 
 Mise à jour locale : Mettre à niveau le dispositif localement. 
 Local Restore Default (Restauration locale des valeurs par défaut) : l’utilisateur peut 

restaurer les paramètres par défaut. 
 Local Shutdown Reboot (Arrêt/redémarrage local) : L’utilisateur peut arrêter et 

redémarrer le dispositif. 
 

 Remote Config (Configuration à distance) 
 Configuration des paramètres à distance : Définir les paramètres à distance, 

restaurer les paramètres par défaut, importer/exporter les paramètres. 
 Configuration de canaux à distance : Ajouter, supprimer, modifier des canaux IP à 

distance. 
 Utilisateur distant : Afficher l’interface utilisateur à distance. 
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 Disque distant : Afficher et définir les plans d’enregistrement, formater les dispositifs 
de stockage à distance. 

 Journal à distance : afficher les journaux système à distance. 
 Mise à jour à distance : mettre à niveau le dispositif sur le Web. 
 Restauration à distance des valeurs par défaut : l’utilisateur peut restaurer les 

paramètres par défaut à distance. 
 Arrêt et redémarrage à distance : l’utilisateur peut arrêter et redémarrer le dispositif 

à distance. 
 Channel Config (Configuration de canaux) 

 Local Preview (Prévisualisation locale) : Prévisualiser la vidéo en direct de chaque 
canal localement. Cette autorisation est détaillée pour chaque canal. 

 Remote Preview (Prévisualisation à distance) : Prévisualiser la vidéo en direct de 
chaque canal à distance. Cette autorisation est détaillée pour chaque canal. 

 Local Record (Enregistrement local) : Définir le plan d’enregistrement de chaque 
canal localement. Cette autorisation est détaillée pour chaque canal. 

 Remote Record (Enregistrement distant) : Définir le plan d’enregistrement de 
chaque canal à distance. Cette autorisation est détaillée pour chaque canal. 

 Local Playback (Lecture locale) : Lire des fichiers vidéo sur le NVR localement. 
Cette autorisation est détaillée pour chaque canal. 

 Remote Playback (Lecture à distance) : Lecture, téléchargement à distance de 
fichiers vidéo sur NVR. Cette autorisation est détaillée pour chaque canal. 

 Local PTZ (PTZ local) : cette autorisation est détaillée pour chaque canal. 
 Remote PTZ (PTZ distant) : cette autorisation est détaillée pour chaque canal. 
 Local Backup (Sauvegarde locale) : Sauvegarder les fichiers vidéo sur le NVR 

localement. Cette autorisation est détaillée pour chaque canal. Les canaux avec des 
droits de sauvegarde locale doivent avoir des droits de lecture locale. 

 Remote Backup (Sauvegarde à distance) : sauvegarde à distance des fichiers vidéo 
du NVR. Cette autorisation est détaillée pour chaque canal. Un canal avec des 
droits de sauvegarde à distance doit avoir des droits de lecture à distance. 

 

REMARQUE 
 Seul l’administrateur admin a le droit de restaurer les paramètres par défaut. 
 Les autorisations de canal prennent en charge les paramètres d’autorisation individuels 

pour un canal. 
 

Étape 6 : Cliquer sur « Save » (Enregistrer) pour enregistrer les autorisations définies et 

retourner à l’interface de gestion des utilisateurs, comme illustré sur la Figure 5-46○4  ci-

dessous. 
 

 

Figure 5-46 ○4  

 
 Modifier l’utilisateur 
Les étapes de fonctionnement spécifiques sont les suivantes : 
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Étape 1 : Dans le menu principal, choisir « →User » pour accéder à l’interface User 
(Utilisateur). 

Étape 2 : Dans le menu principal, cliquer sur « →Modify » pour accéder à l’interface 
Modify User (Modifier utilisateur), comme illustré sur la Figure 5-47 ci-dessous. 
 

 
Figure 5-47 

 
Étape 3 : Modifier les utilisateurs selon les besoins (nom d’utilisateur, mot de passe), puis 
cliquer sur « Save » (Enregistrer). 
 
 Delete the user (Supprimer l’utilisateur) 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →User » pour accéder à l’interface User 
(Utilisateur). 

Étape 2 : Choisir l’utilisateur à supprimer, cliquer sur le «  Delete » (Supprimer) 
correspondant en dessous pour le supprimer. 
Étape 3 : Cliquer sur « Confirm » (Confirmer) pour terminer la suppression de l’utilisateur. 
 
 Modifier mot de passe 

 Les étapes de l’opération sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →User » pour accéder à l’interface User 
(Utilisateur). 

Étape 2 : Sélectionner l’administrateur, cliquer sur «  Modify » (Modifier) pour accéder à 
l’interface de confirmation d’autorisation. Confirmer d’abord le mot de passe. 
Étape 3 : Entrer le mot de passe administrateur, cliquer sur « Save » (Sauvegarder). Une fois 
l’autorisation confirmée, l’utilisateur peut accéder à l’interface de récupération de mot de 
passe, comme illustré sur la Figure 5-48 ci-dessous. 
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Figure 5-48 

 
Étape 4 : Saisir le nouveau mot de passe et confirmer le mot de passe. 
Étape 5 : Choisir les questions de sécurité 1, 2, 3 et définir les réponses correspondantes, 
puis cliquer sur « Save » (Sauvegarder). 
Étape 4 : Insérer la clé USB dans le dispositif, cliquer sur « Export Key » (Exporter la clé). 

REMARQUE 
 
 Lorsque le mot de passe administrateur est modifié pour la première fois, une question 

de sécurité et la réponse correspondante doivent être définies pour réussir à modifier le 
mot de passe. 

 Lors de la modification du mot de passe administrateur, la clé peut ne pas être exportée. 
 Lors de la modification du mot de passe, un motif de déverrouillage peut être défini en 

même temps et l’utilisateur aura une autre façon de se connecter au dispositif. 
 La procédure pour modifier à nouveau le mot de passe administrateur est la 

suivante : 

Étape 1 : Dans le menu principal, choisir « →User » pour accéder à l’interface User 
(Utilisateur). 

Étape 2 : Sélectionner l’administrateur, cliquer sur «  Modify » (Modifier) pour accéder à 
l’interface de confirmation d’autorisation. Confirmer d’abord le mot de passe. 
Étape 3 : Entrer le mot de passe administrateur, cliquer sur « Save » (Sauvegarder). Une fois 
l’autorisation confirmée, l’utilisateur peut accéder à l’interface de récupération de mot de 
passe, comme illustré sur la Figure 5-49 ci-dessous. 
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Figure 5-49 

 
Étapes 4 : Événement normal 
Saisir l’ancien mot de passe, saisir le nouveau de passe et confirmer. 
Étape 5 : Réinitialiser la question de sécurité et la réponse correspondante, puis exporter la 
clé. 
Étape 6 : Cliquer sur « Save » (Enregistrer) pour terminer la modification. 

 

REMARQUE 
 Lors d’une nouvelle modification du mot de passe du dispositif, il ne sera pas nécessaire 

de définir la question de sécurité et d’exporter la clé.  
 Lors de la modification du mot de passe, un motif de déverrouillage peut être défini en 

même temps et l’utilisateur aura une autre façon de se connecter au dispositif. 
 
 
5.3.7.4 Event (Événement) 
Event (Événement) offre deux options : Normal Event et Intelligent Event. 
 Normal Event (Événement normal) 
Normal Event (Événement normal) offre les options suivantes : Motion Detection (Détection 
de mouvement), Video Tampering (Sabotage vidéo), Video Loss (Perte vidéo), Alarm Input 
(Entrée d’alarme), Alarm Output (Sortie d’alarme), Exception et Buzzer, comme illustré sur la 
Figure 5-50 ci-dessous. 
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Figure 5-50 

 
 Motion Detection (Détection de mouvement) 

La détection de mouvement utilise des techniques de vision et de traitement d’image par 
ordinateur pour analyser les images vidéo pour voir s’il y a suffisamment de 
changements dans les images. Lorsque la cible en mouvement apparaît sur l’écran de 
surveillance et que la vitesse de déplacement atteint la sensibilité prédéfinie, le système 
exécute une action de liaison d’alarme. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Normal Event » (Événement normal) pour 
accéder à l’interface Motion Detection (Détection de mouvement), comme illustré sur la 

Figure 5-51 ○1  ci-dessous. 

 

 

Figure 5-51 ○1  

 
Étape 2 : Activer la détection de mouvement et sélectionner un canal. 
Étape 3 : Régler le secteur, la sensibilité. 

 Utiliser la souris pour tracer le secteur sur lequel doit porter la détection de 

mouvement dans la vidéo du canal, comme illustré sur la Figure 5-51 ○2  ci-

dessous. 
 

 Faire glisser le curseur de sensibilité pour sélectionner la sensibilité de 
détection de mouvement appropriée. 

Étape 4 : Cliquer sur « Arming Schedule » (Programme d’amorçage) pour accéder à 

l’interface Arming Schedule, comme illustré sur la Figure 5-51 ○3  ci-dessous. Dessiner 
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l’heure d’amorçage dans le secteur dessiné ou cliquer sur « Edit Time » (Modifier l’heure) 
pour définir le jour de la semaine et la période 1 et 6. 
 

 

Figure 5-51 ○3  

 
Étape 5 : Cliquer sur « Linkage Action » (Action de liaison) pour accéder à l’interface de 
liaison, définir la liaison normale et la sortie d’alarme selon les besoins, comme illustré 

sur la Figure 5-51 ○4  ci-dessous. 

 

 

Figure 5-51 ○4  

 
Étape 6 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage.  

REMARQUE 
 Pour régler la détection de mouvement pour d’autres canaux, répéter les étapes ci-

dessus. 
Après les réglages pour activer la notification par e-mail de la détection de mouvement, 

cliquer sur « Main menu→ →Advanced→E-mail » (Menu principal, Avancés, E-mail) 
pour accéder à l’interface « E-mail setting » et configurer l’e-mail. Lorsque le système envoie 
une alarme de liaison dans la période de temps définie, le destinataire reçoit l’e-mail 
d’alarme. 
 Après que la notification par e-mail a été activé, après que la semaine et la période 

spécifiques ont été définies, uniquement lorsque l’alarme est déclenchée dans la période 
définie, le NVR peut envoyer un e-mail à la boîte aux lettres définie pour avertir 
l’utilisateur. 
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 Si les autres canaux ont les mêmes paramètres de détection de mouvement que ce 
canal, cliquer sur « Copy » (Copier), sélectionner un autre canal et copier les réglages 
de ce canal pour d’autres canaux. 

 
 Channel (Canal) : Sélectionner pour définir le canal. 

 Enable (Activer) : Cocher «  » pour activer/désactiver l’alarme de détection de 
mouvement. 

 Set Area (Définir secteur) : Sélectionner tous les secteurs par défaut, cliquer pour 
accéder à l’interface de réglage de secteur, définir la plage du secteur de détection 
dynamique, appuyer et maintenir enfoncé le bouton gauche de la souris pour 
sélectionner le secteur d’alarme. Après sélection, le secteur d’alarme est remplacé par la 
grille rouge. Sélectionner à nouveau la grille rouge pour annuler le réglage du secteur 
d’alarme. 

 Sensitivity (sensibilité) : Selon le besoin, la sensibilité peut être réglée de 0 à 10 pour 
onze fichiers. Plus la valeur est élevée, plus le dispositif est sensible. 

 Week (semaine) : Sélectionner « All Week » (Toute la semaine) ou cocher (« X ») les 
jours de la semaine voulus pour régler l’heure d’envoi des e-mails d’alarme. Jusqu’à 
deux périodes peuvent être définies chaque jour. 

  : Lorsque « All » (Tous) est sélectionné, cliquer sur «  » pour ne définir 
aucun enregistrement à aucun moment. Lorsque « All » (Tous) n’est pas sélectionné, 

cliquer sur «  » pour définir la date correspondante à ne pas enregistrer. 
 Edit (Modifier) : Cliquer pour accéder à l’interface Record Schedule (Programmation 

d’enregistrement). L’utilisateur peut définir manuellement 6 périodes d’enregistrement 
par jour et copier les réglages à d’autres heures via « Used to » (Utilisé pour). 

 Buzzer Alarm (Alarme sonore) : Cocher «  » pour activer/désactiver la fonction 
d’alarme sonore. 

 E-mail Notification (Notification par E-mail) : Cocher «  » pour activer/désactiver 
lorsque le dispositif alerte la fonction de messagerie. 

 Channel Recording (Enregistrement de canal) : Cocher «  » pour activer/désactiver 
la fonction d’enregistrement de canal. 

 Full Screen Monitoring (Surveillance plein écran) : Lorsqu’une alarme est déclenchée 
sur l’interface de prévisualisation, la vidéo en temps réel du canal du dispositif s’affiche 
en plein écran. 

 Alarm Output (Sortie alarme) : Sélectionner le port de sortie d’alarme. Il est connecté 
au dispositif d’alarme, dans la plage de temps d’alarme définie. Lorsque l’alarme de 
détection de mouvement du dispositif sera activée, elle déclenchera un dispositif 
d’alarme externe pour lancer l’alerte. 

 Copy (Copier) : Une fois le canal configuré, cliquer sur « Copy » (Copier) pour appliquer 
le réglage à un autre canal. 

 

 
 Perte de signal vidéo 

Lorsqu’un canal perd le signal vidéo, le dispositif émet une alarme et avertit l’utilisateur.  
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Normal Event→Video Loss » (Événement 
normal, Perte de signal vidéo) pour accéder à l’interface Video Loss (Perte de signal vidéo), 
comme illustré sur la Figure 5-52 ci-dessous. 
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Figure 5-52 

 

Étape 2 : Choisir un canal et activer Video Loss (Perte de signal vidéo). 
Étape 3 : Régler la liaison normale et la sortie d’alarme selon les besoins.  
Étape 4 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 
 Channel (Canal) : Sélectionner le canal. 

 Enable (Activer) : Cocher «  » pour activer/désactiver l’alarme de perte de signal 
vidéo. 

 Screen Display (Affichage à l’écran) : Lorsqu’une alarme se produit, le dispositif affiche 
un écran d’alarme pour afficher un avertissement. 

 E-mail Notification (Notification par E-mail) : Lorsqu’une alarme se produit, le dispositif 
envoie un e-mail en guise d’avertissement. 

 Buzzer Alarm (Alarme sonore) : Lorsqu’une alarme se produit, le dispositif émet un bip 
en guise d’avertissement. 

 Copy (Copier) : Une fois le canal configuré, cliquer sur « Copy » (Copier) pour appliquer 
le réglage à un autre canal. 
 
 Entrée alarme 

L’entrée d’alarme est le port d’entrée d’alarme du NVR connecté au dispositif d’alarme.  
Lorsque le signe d’alarme est transmis au NVR via le port d’entrée  
d’alarme, le système exécute l’action de liaison d’alarme. 

  
Conditions préalables  
Vérifier que le port d’entrée d’alarme du NVR est connecté au dispositif d’alarme. 

 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Normal Event→Alarm Input » (Événement 
normal, Entrée d’alarme) pour accéder à l’interface Alarm Input (Entrée d’alarme), comme 

illustré sur la Figure 5-53 ○1  ci-dessous. 
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Figure 5-53 ○1  

 

Étape 2 : Sélectionner un canal d’entrée d’alarme, cliquer sur «  » pour accéder à 
l’interface de modification d’Alarm Input (entrée d’alarme), comme illustré sur la Figure 5-

53 ○2  ci-dessous. 

 

 

Figure 5-53 ○2  

 
Étape 3 : Sélectionner le numéro, le nom et le type de l’entrée d’alarme et activer celle-
ci. 
Étape 4 : Dessiner l’heure de l’alarme dans la zone de dessin, ou régler l’heure de 

l’alarme via « Edit » (Modifier), comme illustré sur la Figure 5-53○3  ci-dessous. 
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Figure 5-53 ○3  

 
Étape 5 : Cliquer sur « Linkage Action » (Action de liaison) pour définir la liaison d’alarme 
(liaison normale, enregistrement de canal, sortie d’alarme de déclenchement, affichage 

plein écran), comme illustré sur la Figure 5-53 ○4  ci-dessous. 

 

 

Figure 5-53 ○4  

 
Étape 6 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 Buzzer Alarm (Alarme sonore) : Lorsqu’une alarme se produit, le dispositif émet un bip 

en guise d’avertissement. 
 E-mail Notification (Notification par E-mail) : Lorsqu’une alarme se produit, le dispositif 

envoie un e-mail en guise d’avertissement. 
 Screen Display (Affichage à l’écran) : Lorsqu’une alarme se produit, le dispositif affiche 

un écran d’alarme pour afficher un avertissement. 
 Channel Recording (Enregistrement de canal) : Lorsqu’une alarme se produit, les 

canaux d’alarme 1, 2, 3, 4 enregistrent. 
 Trigger Alarm Output (Déclencher sortie d’alarme) : Lorsqu’une alarme se produit, le 

port de sortie d’alarme de l’équipement est lié à l’alarme. 
 Full Screen Monitoring (Surveillance plein écran) : Une alarme est déclenchée sur 

l’interface de prévisualisation, et une vidéo en temps réel s’affiche en plein écran. Lorsque 
plusieurs canaux sont sélectionnés, la vidéo en temps réel sera affichée pour chaque canal 
tout à tour dans l’ordre des numéros de canal. 

 Copy (Copier) : Une fois le canal configuré, cliquer sur « Copy » (Copier) pour appliquer 
le réglage à un autre canal. 

 
 Sortie alarme 
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La sortie d’alarme fait que le NVR se connecte au dispositif d’alarme (lumières, sirènes, etc.) 
via le port de sortie d’alarme. Lorsqu’une alarme se produit, le NVR transfère les informations 
d’alarme au dispositif d’alarmes. 

 
Conditions préalables  
Vérifier que le port de sortie d’alarme du NVR est connecté à l’alarme. 
 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Normal Event→Alarm Output » 
(Événement normal, Sortie d’alarme) pour accéder à l’interface Alarm Output (Sortie 

d’alarme), comme illustré sur la Figure 5-54 ○1  ci-dessous. 

 

 

Figure 5-54 ○1  

Étape 2 : Sélectionner un canal d’entrée d’alarme, cliquer sur «  » pour accéder à 
l’interface de modification d’Alarm Input (entrée d’alarme), comme illustré sur la Figure 5-

54 ○2  ci-dessous. 

 

Figure 5-54 ○2  
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Étape 3 : Renseigner les champs « Alarm Output » (Sortie d’alarme), « Delay time » 
(Temps de retard), « Alarm Name » (Nom de l’alarme) et « Alarm Status » (État de 
l’alarme). 
Étape 4 : Dessiner le programme d’amorçage dans la zone de dessin ou définir l’heure 
de l’alarme via « Edit » (Modifier). 
Étape 5 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 

 
 Copy (Copier) : Cliquer sur « Copy » (Copier) pour appliquer les réglages du port de sortie 

d’alarme à d’autres ports de sortie d’alarme. 
Trigger (Déclencher) : Cliquer sur «Trigger» (Déclenchement) pour démarrer l’alarme 
correspondant au dispositif  
connecté au port de sortie d’alarme. Le dispositif de sortie d’alarme connecté au canal actuel 
déclenchera une alarme. 
 

 Exception 

Définir le mode d’alarme des événements anormaux. Lorsqu’un événement anormal se 
produit pendant le fonctionnement du dispositif NVR, le système exécute l’action de 
liaison d’alarme. Les types d’événements pris en charge par le dispositif sont « No Disk » 
(Pas de disque), « Disk Error » (Erreur disque), « Broken Network » (Réseau rompu) et 
« IP Conflict » (Conflit IP). 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →Normal→Exception » pour accéder à 
l’interface de réglage Exception, comme illustré sur la Figure 5-55 ci-dessous. 
 

 
Figure 5-55 

 

Étape 2 : Sélectionner le type d’événement, cliquer sur «  » pour activer la fonction 
d’alarme d’exception, choisir le mode de liaison (Screen Display, E-mail Notification, 
Buzzer Alarm [Affichage à l’écran, Notification par e-mail, Alarme sonore]) et le port de 
sortie d’alarme. 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 

 
 Screen Display (Affichage à l’écran) : Lorsqu’une alarme se produit, le dispositif affiche 

un écran d’alarme pour afficher un avertissement. 
 E-mail Notification (Notification par E-mail) : Lorsqu’une alarme se produit, le dispositif 

envoie un e-mail en guise d’avertissement. 
 Buzzer Alarm (Alarme sonore) : Lorsqu’une alarme se produit, le dispositif émet un bip 

en guise d’avertissement. 
 

 Ronfleur 

Les étapes de fonctionnement spécifiques sont les suivantes : 
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Étape 1 : Dans le menu principal, choisir « →Normal Event→Buzzer » (Événement 
normal, Buzzer) pour accéder à l’interface Buzzer setting (Réglage buzzer), comme illustré 
sur la Figure 5-56 ci-dessous. 

 
Figure 5-56 

 

Étape 2 : Régler la durée du buzzer pour l’alarme. 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 

 
 Test : Cliquer sur « Test » pour confirmer le volume et la durée de l’alarme sonore. 
 

 Smart Event (Événement intelligent) (POUR NVR UNIQUEMENT). 

Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Smart Event » pour accéder à l’interface 
« Smart Event » (Événement intelligent), comme illustré sur la Figure 5-57 ci-dessous. 
 

 
Figure 5-57 

 
Étape 2 : Définir la détection intelligente et le mode d’alarme du canal. 
Les types d’alarmes de détection intelligente prises en charge par le dispositif 
comprennent Line Crossing (Détection de franchissement de ligne), Regional intrusion 
(Intrusion régionale), Loitering (Vagabondage) et People Gathering (Rassemblement de 
personnes). 
 

 Line Crossing (Franchissement de ligne) 

La détection de franchissement de ligne peut détecter si un objet traverse la surface 
d’avertissement définie dans la vidéo et déclencher une alarme de liaison en fonction du 
résultat. 
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Les étapes de fonctionnement spécifiques sont les suivantes : 
 

Étape 1 : Dans le menu principal, choisir « →Smart Event » pour accéder à l’interface 
« Smart Event » (Événement intelligent). 
Étape 2 : Choisir le canal requis pour définir la détection de franchissement de ligne, cliquer 
sur « Line Crossing » (Franchissement de ligne) pour accéder au mode de réglage de 

détection de franchissement de ligne, comme illustré sur la Figure 5-58 ○1  ci-dessous. 

 

 
 

Figure 5-58 ○1  

 
Étape 3 : Cliquer sur « Enable→Rule Setting » (Activer→ Définition des règles) pour définir les 
règles de détection de franchissement de ligne. Les étapes spécifiques sont indiquées ci-
dessous : 
1. Dans la liste déroulante « Rules » (Règles), sélectionner les règles selon les besoins. Dans 
la liste déroulante « Rules » (Règles), sélectionner les règles selon les besoins. 

REMARQUE  
 La détection de franchissement de ligne peut définir 4 règles. 

2. Définir le seuil temporel (en secondes) et la sensibilité de la règle. 
 Sensitivity (sensibilité) : Cette option permet de définir la taille de l’objet cible de contrôle. 

Plus la sensibilité est élevée, plus il est facile de considérer l’objet comme étant l’objet 
cible. Plus la sensibilité est élevée, plus il est facile de considérer l’objet comme étant 
l’objet cible. La sensibilité peut être réglée dans la plage de 0 à 100. 

 Direction (Sens) : Trois options sont disponibles : « A <-> B (bidirectionnel) », « A-> B », 
« B-> A », qui font référence au sens dans lequel un objet passe à travers la zone 
d’avertissement pour déclencher une alarme. 
 « A<->B (bidirectionnel) » indique que l’alarme est déclenchée dans les deux sens. 
 « A-> B » indique que l’objet déclenchera une alarme lorsqu’il passera de A à B. 
 « B-> A » indique que l’objet déclenchera une alarme lorsqu’il passera de B à A. 

3. Cliquer sur «  Draw A Line » (Tracer une ligne), déplacer la souris sur l’écran de 
prévisualisation et cliquer successivement sur le bouton gauche de la souris pour dessiner 
les deux extrémités de la ligne d’avertissement. 

REMARQUE  

 L’utilisateur peut modifier la ligne d’avertissement tracée à l’aide des boutons «  Clear 

All » (Supprimer tout) et «  Draw a line » (Tracer une ligne). 
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Étape 4 : Cliquer sur « Processing Method » (Méthode de traitement), définir la liaison d’alarme 
selon les besoins (alarme sonore, notification par e-mail, enregistrement de canal et sortie 

d’alarme de déclenchement), comme illustré sur la Figure 5-58 ○2  ci-dessous. 

 

 

Figure 5-58 ○2  

 
Étape 5 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 

 Regional Intrusion (Intrusion régionale) 
La fonction d’intrusion régionale peut détecter si un objet de la vidéo entre dans la zone définie 
et déclencher une alarme de liaison sur la base du résultat du jugement. 

Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Smart Event » pour accéder à l’interface 
« Smart Event » (Événement intelligent). 
Étape 2 : Choisir le canal requis pour définir l’intrusion régionale, cliquer sur « Regional 
Intrusion » (Intrusion régionale) pour accéder au mode de réglage d’intrusion régionale, comme 

illustré sur la Figure 5-59 ○1  ci-dessous. 

 

 

Figure 5-59 ○1  

 
Étape 3 : Cliquer sur « Enable→Rule Setting » (Activer→ Définition des règles) pour définir les 
règles d’intrusion régionale. Les étapes spécifiques sont indiquées ci-dessous : 

1. Dans la liste déroulante « Rules » (Règles), sélectionner les règles selon les besoins. 
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REMARQUE  
 
1. Intrusion régionale peut définir 4 règles, au choix de l’utilisateur. 
2. Définir le seuil temporel (en secondes) et la sensibilité de la règle. 

 Sensitivity (sensibilité) : Cette option permet de définir la taille de l’objet cible de contrôle. 
Plus la sensibilité est élevée, plus il est facile de considérer l’objet comme étant l’objet 
cible. Plus la sensibilité est élevée, plus il est facile de considérer l’objet comme étant 
l’objet cible. La sensibilité peut être réglée dans la plage de 0 à 100. 

 Time Threshold(s) (Seuils horaires) : Une alarme est générée après que la cible a 
pénétré dans la zone d’avertissement et y a séjourné un certain temps continu. Si le seuil 
de temps est défini à 5 secondes, la zone d’intrusion cible déclenchera une alarme au bout 
de 5 secondes. La plage va de 1 à 10 (secondes). 

3. Cliquer sur «  Draw A Quadrilateral » (Tracer un quadrilatère), déplacer la souris 
sur l’écran de prévisualisation et cliquer en séquence sur le bouton gauche de la souris 
pour dessiner les points d’extrémité de la zone d’avertissement quadrilatérale pour 
terminer le dessin de la zone. 
 

REMARQUE  

 L’utilisateur peut modifier la ligne d’avertissement tracée à l’aide des boutons «  Clear 

All » (Supprimer tout) et «  Draw A Quadrilateral » (Tracer un quadrilatère). 
 

Étape 4 : Cliquer sur « Processing Method » (Méthode de traitement), définir la liaison d’alarme 
selon les besoins (Buzzer, E-mail Notification, Channel Recording, Full Screen Monitoring 
[buzzer, notification par e-mail, enregistrement de canal, surveillance en plain écran]) et Trigger 

Alarm Output (sortie d’alarme de déclenchement), comme illustré sur la Figure 5-59 ○2  ci-

dessous. 
 

 

Figure 5-59 ○2  

 
Étape 5 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 
 Loitering (Vagabondage) 
La fonction Loitering (Vagabondage) peut détecter le temps de séjour de la cible dans la zone 
définie. Lorsque le temps de séjour dépasse le seuil de temps défini, une liaison d’alarme se 
déclenche 

Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Smart Event » pour accéder à l’interface 
« Smart Event » (Événement intelligent). 
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Étape 2 : Choisir le canal requis pour définir le vagabondage, cliquer sur « Loitering » 
(Vagabondage) pour accéder au mode de réglage du vagabondage, comme illustré sur la 

Figure 5-60 ○1  ci-dessous. 

 
                          
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-60 ○1  

 
Étape 3 : Cliquer sur « Enable→Rule Setting » (Activer→ Définition des règles) pour définir les 
règles de vagabondage. Les étapes spécifiques sont indiquées ci-dessous : 

1. Dans la liste déroulante « Rules » (Règles), sélectionner les règles selon les besoins. 

REMARQUE  
 1. Loitering (Vagabondage) peut définir 4 règles, au choix de l’utilisateur.  

2. Définir le seuil temporel (en secondes) et la sensibilité de la règle. 
 Sensitivity (sensibilité) : Cette option permet de définir la taille de l’objet cible de contrôle. 

Plus la sensibilité est élevée, plus il est facile de considérer l’objet comme étant l’objet 
cible. Plus la sensibilité est élevée, plus il est facile de considérer l’objet comme étant 
l’objet cible. La sensibilité peut être réglée dans la plage de 0 à 100. 

 Time Threshold (Min) (Seuil horaire) : Une alarme est générée après que la cible a 
pénétré dans la zone d’avertissement et y a séjourné un certain temps continu. Si le seuil 
de temps est défini à 5 secondes, la zone d’intrusion cible déclenchera une alarme au bout 
de 5 secondes. La plage va de 1 à 10 (secondes). 

3. Cliquer sur «  Draw A Quadrilateral » (Tracer un quadrilatère), déplacer la souris 
sur l’écran de prévisualisation et cliquer en séquence sur le bouton gauche de la souris 
pour dessiner les points d’extrémité de la zone d’avertissement quadrilatérale pour 
terminer le dessin de la zone. 
 

REMARQUE  

 L’utilisateur peut modifier la ligne d’avertissement tracée à l’aide des boutons «  Clear 

All » (Supprimer tout) et «  Draw A Quadrilateral » (Tracer un quadrilatère). 
 
 

Étape 4 : Cliquer sur « Processing Method » (Méthode de traitement), définir la liaison d’alarme 
selon les besoins (Buzzer, E-mail Notification, Channel Recording, Full Screen Monitoring 
[buzzer, notification par e-mail, enregistrement de canal, surveillance en plain écran]) et Trigger 
Alarm Output (sortie d’alarme de déclenchement) selon les besoins, comme illustré sur la 

Figure 5-60 ○2  ci-dessous. 
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Figure 5-60 ○2  

 
Étape 5 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 

 
 People Gathering (Rassemblement de personnes) 
La fonction People gathering (rassemblement de personnes) peut détecter la quantité 
(pourcentage) de personnes dans la zone définie. Si elle dépasse le seuil défini, une liaison 
d’alarme se déclenchera 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Smart Event » pour accéder à l’interface 
« Smart Event » (Événement intelligent). 
Étape 2 : Choisir le canal requis pour définir la fonction People gathering (Rassemblement de 
personnes). Cliquer sur « People gathering » pour accéder au mode de réglage de cette 

fonction, comme illustré sur la Figure 5-61 ○1  ci-dessous. 

 

 

Figure 5-61 ○1  

 
Étape 3 : Cliquer sur « Enable→Rule Setting » (Activer→ Définition des règles) pour définir les 
règles applicables au rassemblement de personnes. Les étapes spécifiques sont indiquées ci-
dessous : 
1. Dans la liste déroulante « Rules » (Règles), sélectionner les règles selon les besoins. 

REMARQUE 
 Le rassemblement de personnes peut définir 4 règles, au choix de l’utilisateur. 
 2. Définir la proportion de règles. 
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 Proportion : Représente la proportion de personnel dans toute la zone d’avertissement. 
Lorsque la proportion de personnel dépasse la valeur de proportion définie, l’alarme du 
système est déclenchée. Sinon le système ne déclenche pas l’alarme. 

3. Cliquer sur «  Draw A Quadrilateral » (Tracer un quadrilatère), déplacer la souris 
sur l’écran de prévisualisation et cliquer en séquence sur le bouton gauche de la souris 
pour dessiner les points d’extrémité de la zone d’avertissement quadrilatérale pour 
terminer le dessin de la zone. 

REMARQUE  

 L’utilisateur peut modifier la ligne d’avertissement tracée à l’aide des boutons «  Clear 

All » (Supprimer tout) et «  Draw A Quadrilateral » (Tracer un quadrilatère). 
 
 

Étape 4 : Cliquer sur « Processing Method » (Méthode de traitement), définir la liaison d’alarme 
selon les besoins (Buzzer, E-mail Notification, Channel Recording, Full Screen Monitoring 
[buzzer, notification par e-mail, enregistrement de canal, surveillance en plain écran]) et Trigger 

Alarm Output (sortie d’alarme de déclenchement), comme illustré sur la Figure 5-61 ○2  ci-

dessous. 
 

 

Figure 5-61 ○2  

 
Étape 5 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 

REMARQUE  
 Lorsque le dispositif prend en charge un dispositif d’alarme externe, la méthode de 

traitement d’alarme peut déclencher la sortie d’alarme. 
 
5.3.7.6 Live View (Vue en direct) 
La fonction Live View (Vue en direct) comprend les options Display (Affichage) et View 
(Visualisation). 
 Display (Affichage) 
La sortie d’affichage permet de définir l’effet d’affichage de l’interface de prévisualisation du 
dispositif, y compris Resolution (Résolution), UI Transparency (Transparence de l’interface 
utilisateur), Show OSD Time (Afficher l’heure OSD) et Show After Boot (Afficher après 
démarrage). 
Les étapes de fonctionnement spécifiques sont les suivantes : 
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Étape 1 : Dans le menu principal, cliquer sur « →Display » pour accéder à l’interface de 
réglage de l’affichage, comme illustré sur la Figure 5-62 ci-dessous. 
 

 
Figure 5-62 

 
Étape 2 : Définir Configurer la résolution, la transparence et d’autres paramètres associés. 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 
 Resolution (résolution) : Les valeurs sélectionnables sont 1024 x 768, 1280 x 720, 

1280 x 1024, 1920 x 1080. L’interface 4K NVR HD prend en charge une résolution de 
sortie jusqu’à 4K. 

 Sub screen Resolution (Résolution d’écran secondaire) : Définir la résolution de 
prévisualisation de l’écran secondaire. Les valeurs sélectionnables sont 1280 × 720, 
1280 × 1024 et 1920 × 1080. 

 UI Transparency (Transparence de l’interface utilisateur) : Plus le pourcentage est 
élevé, plus le menu local du dispositif est transparent. 

 Show OSD Time (Afficher l’heure OSD) : Active/désactive les informations d’heure du 
dispositif affichées sur l’écran du moniteur. 

 Show After Boot (Afficher après démarrage) : Sélectionner (Écran principal) pour 
afficher le numéro de l’écran partagé. 

 Show After Boot (Sub) (Afficher après démarrage) (Secondaire) : Sélectionner le 
numéro de l’écran partagé de l’écran de démarrage secondaire. 

REMARQUE 
 Une fois la résolution de configuration enregistrée, redémarrer le dispositif pour entériner 

la configuration. 
 Seuls les systèmes qui prennent en charge deux écrans ont la possibilité de configurer 

les options Resolution et Show After Boot (Sub) (Afficher après démarrage (secondaire)). 
 
 
 Visualisation 
Certains dispositifs prennent en charge l’accès simultané à plusieurs moniteurs et l’interface 
locale du dispositif peut être affichée sur plusieurs moniteurs en même temps. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur « →View » pour accéder à l’interface de 
réglage View (Visualiser), comme illustré sur la Figure 5-63 ci-dessous. 
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Figure 5-63 

 
Étape 2 : Sélectionner l’interface de sortie vidéo, le canal et l’icône de division de l’image. 
Étape 3 : Cliquer sur « Bind→Apply » (Lier, Appliquer) pour enregistrer le réglage.  
 
 Video output interface (Interface de sortie vidéo :) Port de moniteur externe du NVR. 
 Channel (Canal) : Canal. Permet d’afficher tous les canaux du NVR pour la configuration 

utilisateur. 
 Picture Segmentation (Segmentation de l’image :) Selon le nombre de routes prises en 

charge par le NVR, il y a généralement un seul écran, 4 écrans, 6 écrans, 8 écrans, 9 
écrans, 16 écrans et 36 écrans.  Option. 

 Bind (Lier) : Une fois cette option sélectionnée, la configuration existante peut être liée 
au port de sortie vidéo du dispositif. 

 Unbind (Délier) : Cliquer sur  pour délier le port de sortie vidéo lié. 
 

REMARQUE 
 Le nombre de moniteurs auxquels différents dispositifs peuvent accéder varie, et le 

nombre de divisions d’écran varie également. Se référer au produit réel. 
 
 Logout Preview (Aperçu de déconnexion) 
Après avoir activé la prévisualisation de déconnexion, l’utilisateur peut prévisualiser la vidéo 
en temps réel du canal correspondant lorsque le dispositif se déconnecte. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Logout Preview » pour accéder à l’interface 
Logout preview (Déconnecter prévisualisation), comme illustré sur la Figure 5-64 ci-dessous. 
 

 
Figure 5-64 
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Étape 2 : Sélectionner le canal de prévisualisation. 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour enregistrer le réglage.  
 
 
5.3.8 Maintenance 
La maintenance comprend les options suivantes : System Information, Upgrade, Network 
Information, System Service et HDD Operation (informations système, mise à niveau, 
informations réseau, service système et fonctionnement du disque dur). 
 
5.3.8.1 System Information (Informations système) 
 Dispositif 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Device » pour accéder à l’interface Device 
(Dispositif), comme illustré sur la Figure 5-65 ci-dessous. 
 

 
Figure 5-65 

 
Étape 2 : Afficher le numéro de modèle du NVR, la version du dispositif, la version du système, 
la date de parution et d’autres informations. 
 Caméra 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Camera » pour accéder à l’interface 
Camera, comme illustré sur la Figure 5-66 ci-dessous. 
 

 
Figure 5-66 
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Étape 2 : Afficher les informations d’état des canaux du NVR.  

 
 Enregistrement 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Record » pour accéder à l’interface Record 
(Enregistrement), comme illustré sur la Figure 5-67 ci-dessous. 
 

 
Figure 5-67 

 
Étape 2 : Afficher l’état de l’enregistrement et les paramètres de codage de chaque canal 
NVR. 

 
 Enregistrement des alarmes 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Record » pour accéder à l’interface Record 
(Enregistrement), comme illustré sur la Figure 5-68 ci-dessous. 
 

 
Figure 5-68 

 
Étape 2 : Afficher l’état d’entrée d’alarme de chaque canal du NVR. 

 
 Réseau 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Network » pour accéder à l’interface 
Network (Réseau), comme illustré sur la Figure 5-69 ci-dessous. 
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Figure 5-69 

 
Étape 2 : Vérifier la connexion réseau et la configuration du NVR. 
 Disque dur 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →HDD » pour accéder à l’interface HDD 
(Disque dur), comme illustré sur la Figure 5-70 ci-dessous. 
 

 
Figure 5-70 

 
Étape 2 : Afficher les informations d’état et d’attribut du disque dur connecté au dispositif. 
 
 Log (Journal) 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Log » pour accéder à l’interface Log 
(Journal), comme illustré sur la Figure 5-71 ci-dessous. 



 

 

  103  

  

 
Figure 5-71 

 
Étape 2 : Définir les critères de recherche (type, plage de temps). 
Étape 3 : Cliquer sur « Query » (Demande) pour vérifier le journal. 
Étape 4 : Exporter le journal, insérer la clé USB dans le NVR, cliquer sur « Export » 
(Exporter) et attendre que la progression de l’exportation soit terminée. L’utilisateur peut 
exporter les journaux recherchés vers une clé USB. 
 Type : Sélectionner le type de journal à rechercher. 
 Start/ End (Heure de début/fin) : Entrer la plage temporelle du journal à rechercher. 
 Export (Exporter) : Exporter les informations du journal recherché et stockez-les sur la 

clé USB du dispositif connecté. 
 Export All (Exporter tout) : Exporter et stocker toutes les informations du journal sur la 

clé USB connectée au dispositif.  
 Query (Interroger) : Rechercher les journaux en définissant des critères de recherche et 

les afficher dans la liste des journaux. 
 Page précédente / Page suivante : Fonction de changement de page. Lorsqu’il y a 

beaucoup de journaux dans la période de requête, cliquer pour afficher d’autres 
informations de journal. 

 Clear (Effacer) : Effacer toutes les informations relatives au journal. 

 
 
 Export/Import 
Si plusieurs dispositifs doivent adopter la même configuration, un dispositif peut être 
configuré en premier, et le fichier de configuration du dispositif peut être « exporté » et 
sauvegardé, puis via l’opération « import », la configuration peut être appliquée à d’autres 
dispositifs pour économiser du temps de configuration. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Export/Import » pour accéder à l’interface 
Export/Import, comme illustré sur la Figure 5-72 ci-dessous. 
 

 
Figure 5-72 

 
Étape 2 : Exporter/importer les fichiers de configuration. 

 Config Export (Exporter configuration) : Insérer la clé USB dans le NVR, 
cliquer sur « Config Export » (Exporter configuration) et attendre que la 
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progression de l’exportation soit terminée, puis cliquer sur « Confirm » 
(Confirmer). 

 Config Import (Importer configuration) : Insérer dans le NVR la clé USB sur 
laquelle est stocké le fichier de configuration, cliquer sur « Config Import → 
Confirm » et attendre que la progression de l’importation soit terminée. Le 
dispositif redémarrera. 

 
5.3.8.2 Upgrade (Mise à niveau) 
 Mise à niveau manuelle 
Insérer la clé USB avec le fichier de mise à niveau dans le NVR pour mettre à niveau la 
version du NVR. Si le dispositif détecte le fichier de mise à niveau sur la clé USB, les 
informations sur le logiciel de mise à niveau (numéro de série, nom, taille, date) seront 
affichées dans la liste. 
Les étapes de fonctionnement spécifiques sont les suivantes : 
Étape 1 : Insérer la clé USB avec le fichier de mise à niveau (nommé 
xx_BD_V5_update_Vx.x.x.x.bin) dans le NVR. 

Étape 2 : Dans le menu principal, choisir « →Manual Upgrade » pour accéder à 
l’interface Manual Upgrade (Mise à niveau manuelle), comme illustré sur la Figure 5-73 ci-
dessous. 

 
 

 
Figure 5-73 

 

Étape 3 : Cliquer sur «  Refresh » (Actualiser), choisir le fichier de mise à niveau, cliquer 

sur «  Upgrade→Confirm » (Mettre à niveau → Confirmer), attendre que l’interface 
termine la barre de progression, et le dispositif redémarrera automatiquement pour terminer 
la mise à niveau. 

 

REMARQUE 
 Après plusieurs tentatives d’actualisation, le dispositif ne parvient toujours pas à détecter 

le logiciel de mise à niveau. Vérifier si la clé USB est en bien en contact avec l’interface 
USB du dispositif et si le nom du fichier de mise à niveau est correct. 

 Pendant le processus de mise à niveau, ne pas déconnecter l’alimentation électrique et 
ne pas retirer la clé USB. Le système redémarrera automatiquement une fois la mise à 
niveau terminée. Ce processus prend environ 1 à 6 minutes. Il est recommandé de 
restaurer les paramètres d’usine une fois la mise à niveau terminée avant d’utiliser le 
NVR. 

 
 Mise à niveau en ligne 
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Une fois le NVR connecté au réseau public, le système peut être mis à niveau via une mise à 
niveau en ligne. La mise à niveau en ligne est divisée en mise à niveau automatique et mise 
à niveau par détection manuelle, et la version actuelle du système du dispositif est affichée. 
 Mise à niveau en ligne automatique 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Online Upgrade » pour accéder à l’interface 
Online Upgrade (Mise à niveau en ligne), comme illustré sur la Figure 5-74 ci-dessous. 
 

 
Figure 5-74 

 
Étape 2 : choisir « Auto Update » (mise à niveau automatique). 
Étape 3 : Définir l’heure de mise à niveau du dispositif. Cliquer sur « Apply » (Appliquer). 
Lorsqu’il y a une nouvelle version dans le cloud, le système détecte automatiquement la 
version et met à niveau le dispositif à l’heure définie. 
 
 Mise à niveau manuelle en ligne 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Online Upgrade » pour accéder à 
l’interface Online Upgrade (Mise à niveau en ligne). 
Étape 2 : Cliquer sur « Check » (Vérifier), une interface d’invite apparaît. Si une nouvelle 
version est détectée, le système vous demandera des informations sur la nouvelle version. 
Étape 3 : Cliquer sur « Update » (Mettre à jour) et attendre que le dispositif télécharge le 
fichier de mise à jour. Une fois le dispositif mis à jour, le dispositif redémarrera 
automatiquement. 
 Status (Statut) : La version actuelle du dispositif. 

 Auto update (Mise à jour auto) : Cliquer sur  «  » pour activer la fonction de mise 
à jour automatique du système. Lorsque le dispositif détecte la nouvelle version en ligne, 
il se met automatiquement à jour en fonction de l’heure de mise à jour. 

 Update time (Heure e mise à jour) : Régler l’heure de mise à jour automatique. 
 Check (Vérification) : Détecter la dernière version en ligne. 

REMARQUE 
 Avant de tester une nouvelle version en ligne, s’assurer que le NVR est correctement 

connecté au réseau. 
 Pendant le processus de mise à niveau, ne pas couper l’alimentation ni retirer la clé 

USB. Après la mise à niveau, votre système redémarrera automatiquement. (Ce 
processus prendra environ 1 à 6 minutes.) Après cela, nous vous conseillons de 
restaurer les paramètres d’usine après la mise à niveau. 

 

 
 Default (Valeur par défaut) : 
Lorsque le dispositif NVR fonctionne lentement ou si la configuration est incorrecte, 
l’utilisateur peut essayer de résoudre le problème en restaurant les valeurs par défaut. 
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Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Default » pour accéder à l’interface 
Default (Valeur par défaut), comme illustré sur la Figure 5-75 ci-dessous. 
 

 
Figure 5-75 

 
Étape 2 : Sélectionner les éléments de configuration qui doivent être restaurés aux 
paramètres d’usine. 
Étape 3 : Cliquer sur « Apply→OK » (Appliquer→OK). 
 
 Restore Storage Default Param (Restaurer les paramètres de stockage par défaut) : 

Sélectionner/Annuler pour restaurer tous les paramètres de configuration de stockage 
aux valeurs par défaut.  

 
 Restore Camera Default Param (Restaurer les paramètres de caméra par défaut) : 

Sélectionner/Annuler pour restaurer tous les paramètres de configuration des caméras 
aux valeurs par défaut.  

 
 Restore System Default Param (Restaurer les paramètres système par défaut) : 

Sélectionner/Annuler pour restaurer tous les paramètres de configuration système aux 
valeurs par défaut.  

 Restore Maintenance Default Param (Restaurer les paramètres de maintenance par 
défaut) : Sélectionner/Annuler pour restaurer tous les paramètres de configuration de 
maintenance aux valeurs par défaut. 

 Restore Factory Settings (Restaurer réglages d’usine) : Sélectionner/Annuler pour 
restaurer tous les paramètres du NVR aux valeurs par défaut. 

REMARQUE 
 Après la restauration des paramètres d’usine, les fonctions correspondantes seront 

restaurées aux paramètres d’usine. La configuration existante de l’utilisateur peut être 
perdue. Poursuivre avec REMARQUE. 

 
5.3.8.3 Network Information (Informations réseau) 
 Network Traffic (Trafic réseau) 
Le trafic réseau fait référence au trafic de données utilisé par les fichiers vidéo par unité de 
temps. Grâce à la surveillance du trafic réseau, l’utilisateur peut afficher le flux de code en 
temps réel et les changements du signal de flux de code de chaque canal en temps réel. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Network Trafic » pour accéder à l’interface 
Network Trafic (Trafic réseau), comme illustré sur la Figure 5-76 ci-dessous. 
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Figure 5-76 

 
Étape 2 : Visualiser le trafic réseau de chaque canal en temps réel.  
 
 Network Detection (Détection réseau) 
Détection réseau consiste à tester le retard du réseau et la perte de paquets. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Network Detection » pour accéder à 
l’interface Network Detection (Detection réseau), comme illustré sur la Figure 5-77 ci-
dessous. 
 

 
Figure 5-77 

 
Étape 2 : Sélectionner le NIC (Contrôleur d’interface réseau), saisir l’adresse de test dans la 
barre d’adresse de destination. 
Étape 3 : Cliquer sur « Test » pour faire le « Network Delay, Packet Loss Test » (test de délai 
réseau et de perte de paquets). Après le test, le système affichera les résultats, à savoir le 
taux de perte de paquets et le retard moyen.  
 
 Auto Maintain (Maintenance automatique) 
Lorsque le dispositif fonctionne pendant une longue période, l’utilisateur peut configurer le 
dispositif pour qu’il redémarre dans les limites d’un délai d’inactivité pour augmenter la vitesse 
de fonctionnement du dispositif.  
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →Auto Maintain » pour accéder à l’interface 
Auto Maintain (Maintenance automatique), comme illustré sur la Figure 5-78 ci-dessous. 
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Figure 5-78 

 
Étape 2 : Sélectionner l’heure pour « Auto Maintain ». 
Étape 3 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 

REMARQUE 
 Le redémarrage automatique du système peut être réglé selon un cycle à heure fixe 

(chaque mois, chaque semaine, chaque jour) défini pour redémarrer le dispositif. 
L’utilisateur peut également choisir « Never » (Jamais). Dans ce cas, l’équipement n’aura 
pas de maintenance automatique. 

 
5.3.8.4 Fonctionnement du HDD 
 S.M.A.R.T. (POUR NVR UNIQUEMENT) 
S.M.A.R.T. permet de surveiller la température du disque dur, le matériau de surface du 
disque, le moteur et son système d’entraînement, et d’analyser et de prévoir les problèmes 
éventuels du disque dur. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, choisir « →S.M.A.R.T. » pour accéder à l’interface 
S.M.A.R.T., comme illustré sur la Figure 5-79 ci-dessous. 
 

 
Figure 5-79 

 
Étape 2 : Sélectionner le disque dur à tester et définir le « Test Type » (Type de test). 
Étape 3 : Le dispositif entreprend de détecter le disque dur. 
Étape 4 : Une fois le disque dur détecté, les détails du disque dur sont affichés dans la liste 
d’informations S.M.A.R.T. 
 Configuration S.M.A.R.T. :  

 Disk No. (N° de disque) : Dérouler la liste pour sélectionner le numéro du l’unité. 
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 Test condition (Condition de test) : Indique si le disque dur a été détecté. 
 Test type (Type de test) : Short (Court) ou Extended (Étendu). 
 Temperature (Température) : Afficher la température du disque dur. 
 Utility time(h) (Temps d’utilité (h) : Indique la durée d’utilisation du disque dur 

(heures). 
 Self-assessment (Auto-évaluation) : Indique si le disque dur a été accepté. 
 Overall-assessment (Évaluation globale) : Indique si le disque entier est correct. 

 Informations S.M.A.R.T. : Afficher les informations relatives au disque dur. 
 Self test (Auto-test) : Cliquer sur « Self test » (Auto-test) pour détecter les informations 

relatives au disque dur. 

REMARQUE 
 Seuls certains dispositifs prennent en charge la détection du disque dur. Se référer à la 

situation réelle. 
 Lorsque les résultats de l’auto-évaluation ou de l’évaluation globale indiquent « not 

passed » (refusé), le disque dur doit être remplacé pour éviter la perte de données. 
 Grâce à la fonction d’autotest S.M.A.R.T., l’utilisateur peut effectuer un autotest sur le 

disque dur afin de détecter l’état général du disque dur.  

 
 
 
5.3.9 Alarm Information (Informations alarmes) 
 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur «  » pour accéder à l’interface « Alarm 
Information » (Informations alarmes), comme illustré sur la Figure 5-80 ci-dessous. 
 

 
Figure 5-80 

 
Étape 2 : Afficher les informations d’anomalies et diverses alarmes du dispositif. 

Étape 3 : Cliquer sur «  Set » pour accéder à l’interface « Event Hint Setting » (Réglage 
suggestion événement), aux informations d’événements anormaux et à diverses alarmes 
affichées sur l’interface, comme illustré sur la Figure 5-81 ci-dessous. 
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Figure 5-81 

 
Étape 4 : Cliquer sur « Apply » (Appliquer) pour sauvegarder le réglage. 
 
5.3.10 Backup Process (Processus de sauvegarde) 
 

Dans le menu principal, cliquer sur «  » pour accéder à l’interface Backup Process 
(Processus de sauvegarde). L’utilisateur peut visualiser la progression de la sauvegarde du 
fichier, mettre en pause ou supprimer le fichier de sauvegarde, comme illustré sur la Figure 5-
7. 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur «  » pour accéder à l’interface de 
sauvegarde, comme illustré sur la Figure 5-82 ci-dessous. 
 

 

 
Figure 5-82 

 
Étape 2 : Visualiser la progression de la sauvegarde du fichier, mettre en pause et supprimer 
le fichier de sauvegarde. 
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REMARQUE 
 La clé USB a été insérée dans le dispositif et le fichier de sauvegarde a été sélectionné 

pour la sauvegarde. Ensuite, l’utilisateur peut visualiser les informations relatives à la 
sauvegarde sur l’interface de progression de la sauvegarde. 

 
 
5.3.11 Fermeture 
Les étapes de fonctionnement spécifiques sont les suivantes : 

Étape 1 : Dans le menu principal, cliquer sur «  » pour accéder à l’interface de 
fermeture, comme illustré sur la Figure 5-83 ci-dessous. 
 

 
Figure 5-83 

 
Étape 2 : Effectuer l’opération correspondante selon les besoins (déconnexion, redémarrage, 
arrêt). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 




